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Intended Uses

Preface

The Selenia®, based on the M-IVTM Mammography X-ray System, uses an Image Acquisition 
system that includes a digital image receptor. This receptor, which covers an area of 24 cm x 
29 cm, is a direct-capture detector using an amorphous selenium photoconductor. At the 
Acquisition Workstation the user selects X-ray exposure technique factors, adds patient 
identification data, acquires, processes, and displays the digital images. The images are then 
either processed for printing and transmitted to peripheral hard copy laser film printer or sent 
to a diagnostic review workstation or both. Contrast and brightness are set automatically and 
can be adjusted by the user prior to printing or viewing. Hard-copy printers and a diagnostic 
review workstation are available as options. 

The patient is prepared for the procedure in the same manner as for a film-based system. The 
Acquisition Workstation provides direct digital acquisition system advantages in system 
efficiency and productivity including:

• Patient demographics are associated with the electronic image.

• Technologist comments can be associated with the image.

• The technologist is assisted through the steps of image acquisition.

• Possible image destinations are provided via configurable settings.

• The technologist may review past acquisitions (including priors), to see previous 
captures, and then resend, and/or remark them.

1.0 Intended Uses
United States Federal Law restricts this device to use by or on the order of a physician.

The Selenia is intended to produce radiographic images of the breast. Its intended use is for 
the production, storage, and diagnostic review of digital screening, diagnostic, and needle 
localization mammography.

The system is to be used in a radiology or clinic exam room environment in a hospital, 
outpatient clinic, or a breast imaging center. Mammography technologists operate the system 
for the production and storage of digital mammograms. The system may also be used for 
quality control purposes and other clinical or research related activities by medical physicists 
and radiologists certified in accordance with MQSA standards.

• The Selenia Acquisition Workstation display is not approved for final interpretation of 
examinations. Final interpretations should be done from either films or with the 
diagnostic review workstation. Images shown on the Acquisition Workstation display are 
for quality assurance or confirmation purposes only.

• Only images produced by recommended laser printers, or an approved diagnostic 
review workstation, should be used for final interpretation of examinations. For 
compatible printers, see the latest product data sheets for the system, which can be 
obtained from Hologic® or your sales representative.
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1.1 Indications For Use
The Selenia Full Field Digital Mammography System generates digital mammographic 
images that can be used for screening and diagnosis of breast cancer. The Selenia Full Field 
Digital Mammography System is intended for use in the same clinical applications as 
traditional screen-film mammographic systems. Mammographic images can be interpreted 
on either hard copy film or the diagnostic review workstation.

1.2 Contraindications
There are no known contraindications.

1.3 Potential Adverse Effects
The following is a list of potential adverse effects that apply to mammography and are also 
applicable to digital mammography using the Selenia.

• Excessive breast compression

• Excessive X-ray exposure

• Electric shock

• Infection

• Skin irritation, abrasions, or puncture wounds

1.4 Product Complaints
Report any complaint or dissatisfaction in the quality, durability, reliability, safety, 
effectiveness, and/or performance of this product to Hologic. If the device has caused or 
contributed to a serious injury of a patient, immediately report the incident to Hologic. (See 
the Title Page for contact information.)

1.5 Summary of Clinical Studies
This information is available in the document MAN-02233.

2.0 Quality Control
Perform all Quality control tests within the correct time frame.

3.0 User Training
Hologic does not accept the responsibility for injury or damage caused by incorrect system 
operation. Hologic can arrange for training by a clinical application specialist. Refer to this 
Instructions for Use manual for directions on how to use the Selenia.

4.0 Skills Needed for System Use
You must understand how to use a personal computer system, internal and external storage 
media (DVDs, CDs, diskettes, etc.), and external computer peripherals (keyboard, trackball, 
printers).
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Terms and Definitions

5.0 Terms and Definitions
Accession Number A DICOM term that refers to a RIS-created number that uniquely 

identifies a visit to a site by a patient. 
ACR American College of Radiology
Ag Silver
AEC Automatic Exposure Control. A method that limits the amount of 

radiation a patient receives.
collimator Device at the X-ray tube that limits the area of the receptor that is 

exposed.
dialog box Device at the X-ray tube that limits the area of the receptor that is 

exposed.
DICOM Digital Imaging and Communications in Medicine. An industry 

standard specification for communication between medical 
imaging equipment.

digital marker A software mechanism that marks an image to indicate some 
information (normally orientation).

FAST Paddle™ Fully Automated Self-Adjusting Tilt Paddle system
Grid Element within the Digital Image Receptor that reduces the scatter 

radiation during exposure
HIS/RIS Hospital Information System/Radiology Information System. 

Generic term for non-PACS systems which track the Patient 
demographics and ordered radiological studies

HTC™ High Transmission Cellular Grid
kV Kilovolts: One of the x-ray exposure settings.
login/logout The process of logging into and out of the Operating System of the 

Acquisition Workstation
LUT Look-Up Table (LUT). An image processing function that replaces 

one image pixel value with a different image pixel value.
Mag Magnification
mA Milliamperes. One of the x-ray exposure settings.
mAs Milliampere-seconds. An electrical term used in x-ray exposure 

settings 
Mo Molybdenum
Modality Worklist 
(MWL)

A list of scheduled procedures normally kept by a RIS or PACS.

MPPS Modality Performed Procedure Step. A DICOM service to allow 
the RIS (or another device) to know about work performed on the 
AWS.

MQSA Mammography Quality Standards Act
Operating System (OS) The software control system which runs all functions of a 

computer. 
Outputs A list of devices to which the accepted image is sent. The devices 

can be a combination of archives, workstations and film printers.
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PACS Picture Archiving and Communications System. A computer and 
network system for the transfer and archive of digital medical 
images

PPS Status The condition of a Performed Procedure Step being “in progress”, 
“completed”, or “discontinued”.

Procedure A generic medical protocol which contains a set of images 
(Views) which are acquired under certain conditions, and are 
performed together for a one purpose (for example standard 
screening). There is no Procedure instance UID item because a 
Procedure is a generic item in DICOM. DICOM supports the 
identification of requested Procedures.

Rh Rhodium
ROI Region of Interest
RIS Radiology Information System
Series A set of images acquired by a single tech for a single Patient and 

Procedure on a particular modality with a fixed body part, 
laterality and view position. DICOM uniquely identifies the series 
with a globally unique instance UID. Based on this description, 
each individually acquired DR image on the Acquisition 
Workstation is also an individual series.

Sign-in The process of user identification to the Acquisition Workstation 
application.

Sign-out The process in which a user exits the Acquisition Workstation 
application, but the user does not logout of the OS.

Smart Paddle™ A paddle with a release knob on each side which allows the 
paddle to move from one side of the image detector to the other. 
The system identifies a Smart Paddle installed on the compression 
device.

Solaris™ The company Sun™ Microsystems’ version of the UNIX 
Operating System.

TEC Tissue Exposure Control mode, an enhanced Manual Exposure 
Control (MEC) mode.

TechMate™ The Hologic SecurViewRT technologist review workstation 
accessory, as packaged with the Selenia to reduce space in the 
examination room.

technique Combination of X-ray parameters (kV, mA, etc.) for a specified 
view in a procedure.

UPS Uninterruptible Power Supply.
View The combination of a single X-ray image and a specified set of 

conditions under which the image was acquired. The View is not 
part of DICOM nomenclature, but in the context of DR, is 
approximately synonymous with a DICOM image object.

W Tungsten
Wildcard Character A keyboard character that represents one or many characters, for 

example the * or ?.
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Warnings, Cautions, and Notes

6.0 Warnings, Cautions, and Notes
Descriptions of Warnings, Cautions, and Notes used in this manual:

WARNING! Procedures that you must follow accurately to prevent 
possible dangerous or fatal injury.

Warning: Procedures that you must follow accurately to prevent injury.

Caution: Procedures that you must follow accurately to prevent the damage to 
equipment, loss of data, or damage of files in software applications.

Note… Notes indicate additional information.

7.0 International Symbols
This section explains the International Symbols used on this system.

Table P-1: International Symbols

Potential Equalization 
terminal

Connection for a conductor other than the Protective 
Earth for a direct connection between two or more pieces 
of electrical equipment.

Protective Earth 
terminal

Used for the connection of the ground of the line cord or 
ground cable of the equipment and no other purpose.

Off Power disconnection from the mains

On Power connection to the mains

Off Off, only for a part of equipment

On On, only for a part of equipment

WEEE
Symbol indicating separate collection for electrical and 

electronic equipment

Dangerous Voltage Identifies area of potentially lethal voltage

Manufacturer

Date of Manufacture

X-ray Radiation Caution—Radiation
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8.0 How to Use this Document
• The Preface describes intended system use and identifies the skills a system user needs.

• Chapter 1 provides general safety information.

• Chapters 2, 3, and 4 describe system hardware, system startup/shutdown and functional 
tests.

• Chapter 5 steps you through a screening exam and the user interface.

• Chapters 6, 7, and 8 describe the options on the user interface screens while logged on 
as a “tech”.

• Chapter 9 describes system Maintenance and Cleaning procedures.

• Appendix A states specifications for the system.

• Appendix B provides information about Selenia in a mobile environment.
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Chapter 1 - General Information

1.0 Warnings and Precautions
Read and understand this manual before you use the system. Always follow all the 
instructions in this manual.

This system is for use by qualified Operators only. The Operators must have experience in the 
principles of mammography before following the instructions contained in this manual. 

The Selenia system is classified as CLASS I, TYPE B permanently connected equipment as per 
IEC 60601-1. There are no special provisions to protect the system from flammable 
anesthetics or ingress of liquids.

WARNING! Do not open any of the panels. Lethal voltages are present 
within the interior of this unit. 

WARNING! Do not use the electrical equipment near flammable 
anesthetics.

WARNING! The user or the service personnel must correct problems 
before the system is used.

WARNING! The user must arrange for preventive maintenance by an 
authorized service representative.

WARNING: This X-ray unit can be dangerous to patient and the user. 
Always follow the safety precautions for x-ray exposures.

WARNING! After a power failure, remove the patient from the system 
before you apply power.

WARNING! To keep the isolation quality for the system, attach only 
approved accessories or options to the system. Only the 
authorized personnel can make changes to the 
connections.
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WARNING! Keep a 1.5 meter safe distance between the patient and 
any non-patient devices.
Non-patient system components (like the Workflow 
Manager, the diagnostic review workstation, or the 
hardcopy printer) must not be installed in the Patient Area

WARNING! Per North American electrical safety requirements, 
grounding reliability can only be achieved when the 
Acquisition Workstation is connected to a receptacle 
marked Hospital Grade.

WARNING! The disk drives installed in this system are a Class I Laser 
Product. Prevent direct exposure to the beam. Hidden 
laser radiation exists if the case to a disk drive is open.

Warning: This unit is for use only by qualified personnel.

Warning: Control the access to the equipment according to local 
regulations for radiation protection.

Warning: You must keep your complete body behind the radiation shield 
for the time of the exposure for maximum protection from x-ray 
exposure.

Warning: This device contains dangerous material. Return to Hologic all 
material removed from service.
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Warning: Motorized equipment. Use care when adjusting for patient use. 
Observe equipment and patient at all times during set up. If a 
chair is necessary use an adjustable chair set above its minimum 
height.

Warning: Put the footswitches where a patient user, or wheelchair cannot 
accidentally activate a switch.

Warning: Never leave the patient during the procedure if in contact with 
the mammography unit.

Warning: Keep the hands of the patient away from all buttons and 
switches at all times.

Warning: You increase the patient dose to high levels if you increase the 
AEC exposure adjustment setting. You increase the image noise 
or decrease image quality if you decrease the AEC exposure 
adjustment setting.

Warning: Increased Exposure adjustment leads to higher dose to the 
patient. Keep the patient dose as low as practical to get good 
image quality.

Warning: If a paddle touches possible infectious materials, call your 
Infection Control Representative for decontamination 
instructions.

Warning: The bar code scanner installed in this system is a Class II Laser 
Product. Prevent direct exposure to the beam. Hidden laser 
radiation exists if the cover is opened.

Warning: The Face Shield does not protect from radiation. 

Caution: Do not use any heat source on the image receptor.



4 Part Number MAN-01384 

Instructions for Use
Chapter 1 - General Information
Warnings and Precautions

Caution: Never turn off the Acquisition Workstation Circuit Breaker except in 
emergency. The circuit breaker can turn off the Uninterruptible Power 
Supply (UPS) and risk data loss.

Caution: To minimize possible damage from thermal shock to the Digital Image 
Receptor, follow the recommended procedure to turn off the 
equipment.

Caution: Do not put any magnetic media near or on devices that create any 
magnetic fields, because stored data can be lost. 

Caution: This system is a medical device and not a normal computer. Do not 
make changes to the hardware or software that are not authorized. 
Install this device behind a firewall for network security. The 
computer virus protection or network security for this medical device 
is provided (for example, a computer firewall). The network security 
and anti-virus provisions are the responsibility of the user.

Caution: Software other than those provided specifically for use with this 
system must not be loaded onto the system.

Caution: Only use the approved accessories with this equipment. The failure to 
follow this caution can cause errors and possible data loss.
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2.0 Radiation Safety

2.1 Exposure Duration

2.2 Operator Radiation Shield
The radiation shield meets the requirements of 21CFR 1020 and IEC 60601-2-45.2001. The 
shield has a rating of a 0.5 mm Pb (lead) equivalent and is permanently installed.

Note… Verify the shield integrity every day before use.

2.3 Patient Face Shield

The Patient Face Shield keeps the face of the patient out of the radiation field.

2.4 Exam Room Door Indicators
• The system provides for an external Power-On indicator.

• The system provides for an external X-ray Exposure In Progress indicator.

3.0 Mechanical Safety
The equipment meets the requirements of IEC 60601-1, UL 60601, and CSA 22.2 No. 601.1 
by these safety features:

• The C-arm rotation braking is ensured upon loss of power.

• Compression release is disabled when a localization paddle is installed.

• Motorized compression force has a limit of 200 N (45 lb).

4.0 Emergency Off Switches
The Emergency Off switches remove the power from the Gantry. Do not normally use the 
Emergency Off switches to turn off the system. Refer to Chapter 2, page 13. 

Table 1-1: Factors That Limit Exposure Duration

Normal Factors Abnormal Factors

Manual mAs Timer • Release of the x-ray button before the exposure ends.

• Exposure longer than the preset “back-up time”

• The independent safety hardware back-up timer.

• Detection of a generator fault
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5.0 Interlocks
• Display of 58 Newtons (13 lb) or greater of compression force disables the C-arm 

vertical drive and rotation.

• Installation of a Localization Paddle disables the automatic compression release 
functions.

• Release of an X-ray button before the end of the exposure ends the exposure.

• Misalignment of the Light Field Mirror or the Filter prevents an X-ray exposure.

• Installation of an 18 x 24 cm shifting paddle prevents the X-ray exposure if the detected 
paddle position does not match the View.

6.0 Compliance
This section describes the mammography system compliance requirements and the 
manufacturer responsibilities.

6.1 Compliance Requirements
The manufacturer is responsible for the effects of safety, reliability, and performance of this 
equipment with the following provisions:

• The electrical installation of the room complies with the appropriate requirements.

• The equipment is used in accordance with instructions for use.

• Assembly operations, extensions, re-adjustments, modifications, or repairs are 
performed by authorized persons only.

• The installed network and communications equipment must comply with an IEC 
Standard, and the complete system (network/communications equipment and Selenia 
Mammography System) must be installed to comply with IEC 60601-1 and IEC 
60601-1-1.

Caution: Medical Electrical Equipment needs special precautions about EMC 
and must be installed, put into service and used according to the EMC 
information provided.

Caution: Portable and Mobile RF communications can affect Medical Electrical 
Equipment.

Caution: The use of unauthorized accessories and cables can result in increased 
emissions or decreased immunity. To keep the isolation quality for the 
system, attach only approved accessories or options to the system.

Caution: The Medical Electrical (ME) Equipment or ME System should not be used 
adjacent to or stacked with other equipment. If adjacent or stacked use 
is necessary, the ME Equipment or ME System should be observed to 
verify normal operation in the configuration in which it is used.
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Caution: This system is intended for use by healthcare professionals only. This 
system may cause radio interference or may disrupt the operation of 
nearby equipment. It may be necessary to take mitigation measures, 
such as re-orienting or relocating the equipment or shielding the 
location.

Caution: Changes or modifications not expressly approved by Hologic could 
void your authority to operate the equipment.

6.2 Compliance Statements
The manufacturer states that this device is manufactured/conforms to:

• EN ISO 13485:2007

• FDA, 21 CFR [Parts 820, 900 and 1020]

• IEC 60601-1:1988 +A1+A2:1995 +A13:1996 Medical Electrical Equipment—General 
requirements for safety 

• IEC 60601-1-1:2000-12 Medical Electrical Equipment—Collateral Standard: Safety 
requirements for medical electrical systems

• IEC 60601-1-2:2001 Medical Electrical Equipment—Collateral Standard: 
Electromagnetic compatibility for medical electric systems 

• IEC 60601-1-3:1994 Medical Electrical Equipment—Collateral Standard: Requirements 
for radiation protection in diagnostic x-ray equipment

• IEC 60601-1-4:1996 +A1:1999 Medical Electrical Equipment—Collateral Standard: 
Programmable electrical medical systems

• IEC 60601-1-6 Medical Electrical Equipment—Collateral Standard: Usability 

• IEC 60601-2-28:1993-03 Medical Electrical Equipment—Particular requirements for the 
safety of x-ray source assemblies and x-ray tube assemblies for medical diagnosis

• IEC 60601-2-32:1994 Medical Electrical Equipment—Particular requirements for the 
safety of associated equipment of x-ray equipment 

• IEC 60601-2-45:2001 Medical Electrical Equipment—Particular requirements for the 
safety of mammographic x-ray equipment and mammographic stereotactic devices

• IEC 62304:2006 Medical Device Software—Software life cycle processes

• UL 60601-1: Medical Electrical Equipment, Part 1—General Requirements for Safety

• CSA: Medical Electrical Equipment Part 1: C22.2 No. 601.1–M90—General 
Requirements for Safety

• ISO 14971
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7.0 Label Locations

Figure 1-1: Selenia Label Locations
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Figure 1-2: Selenia Value Console Label Locations
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Chapter 2 - System Components and Controls

1.0 System Description
The Selenia is available with an Acquisition Workstation or a Value Console. The Acquisition 
Workstation can also include a technologist review workstation accessory (the Hologic 
SecurViewRT TechMateTM) packaged with the Selenia to reduce space requirements.

Figure 2-1: Selenia System Description

Legend for Figure 2-1

• The Selenia Acquisition Workstation (1) and the Value Console (2) contain the image 
processing electronics and provide the user interface.

• The SecurViewRTTechMate (3) provides a Technologist review workstation accessory.

• The Tubestand is the C-arm (4) and the Gantry(5).

The C-arm provides a platform for the X-ray tube, compression systems, and the digital 
image receptor. A pivot mechanism connects it to the Gantry.

The Gantry contains the electrical and mechanical subsystems for the Selenia.

• Dual-function Footswitches (6) allow hands-free C-arm vertical travel and compression 
movements.

2.0 Film Printer
Selenia accepts film printers. Printed films display the patient information, exposure 
techniques, projection, and facility information.
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3.0 System Power Controls

3.1 Input Power Circuit Breakers

Location of Circuit Breaker Description

Figure 2-2: Gantry Circuit Breaker

• At the lower right corner of the 
back panel

• Removes the power for service 
or in an emergency

• Up is turned On. Down is 
turned Off.

• When turned off, a system 
restart is required. Restart the 
system following Chapter 3, 
Section 1.0, page 23.

Figure 2-3: Acquisition Workstation Circuit Breaker

• On the back of the Acquisition 
Workstation behind the shield. 
The Value Console Circuit 
Breaker (not shown) is on the 
back of the Value Console.

• Use only in an emergency.

• If the circuit breaker was used, 
wait until the beeps stop, then 
turn on the circuit breaker. The 
system automatically restarts. If 
the UPS does not respond 
automatically, reset the UPS. 
See Chapter 3, Section 4.3, 
page 30.
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3.2 Emergency Off Switches

• Press any Emergency Off Switch to remove 
Gantry power.

• Rotate the switch one-quarter turn to reset.

• Restart the system after any Emergency Off 
Switch is pressed. Refer to procedure in 
Chapter 3, Section 4.2, page 29.

Figure 2-4: Emergency Off Switch

Location of Emergency Off Switches

Figure 2-5: Acquisition Workstation Emergency Off 
Switch

Figure 2-6: Gantry Emergency Off 
SwitchesFigure 2-7: Value Console Emergency Off Switch
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4.0 Acquisition Workstation Controls and Display

4.1 Acquisition Workstation

Figure 2-8: The Acquisition Workstation Controls Figure 2-9: The Selenia Value Console Controls 
Legend for Figure 2-8
1. Circuit Breaker 

2. Emergency Off Switch

3. Selenia Display

4. Trackball

5. CD-RW Drive

6. Left and Right Keypads

7. Selenia Acquisition Workstation UPS 
(Uninterruptible Power Supply) Reset Button (on 
lower right back)

8. Bar Code Scanner

9. Selenia Keyboard

Legend for Figure 2-9 
1. Computer

2. Bar Code Scanner

3. Left and Right Keypads

4. Keyboard

5. Display

6. Emergency Off Switch

7. Mouse

8. Circuit Breaker

9. CD-RW Drive

10. UPS
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4.2 Keypads
The Keypads provide Power On, X-ray, and Compression Release functions.

Figure 2-10: Keypad Controls

Legend for Figure 2-10

4.3 Keyboard and Trackball or Mouse

Figure 2-11: Selenia Keyboard

Legend for Figure 2-11

1. Power On button. 

2. Power On indicator light. 

3. X-ray Indicator lights on both panels.

4. X-ray buttons, one on each side of the keyboard. 
Press both at the same time to begin an x-ray 
exposure and hold until the tone stops.

5. Compression Release button. 

1. Selenia Function keys

2. Trackball (Acquisition Workstation)

3. Future Use

4. Standard keyboard keys

5. Standard arrow keys

6. Standard number keypad

7. Mouse (Value Console)

Mode Filter kV kV SpotmAs mAs Breast
Dens

New
Entry

Close
Exam

Num LockUNIX Keyboard Caps Lock Scroll Lock Compose

Grid
In/out

Aec
Pos
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4.4 Keyboard and Screen Controls
Use the trackball or the function keys to change Exposure techniques.

Figure 2-12: Selenia Function Keys on the Keyboard

4.5 Bar Code Scanner
The Bar Code Scanner speeds the entry of data from records with bar codes.

Table 2-1: Selenia Function Keys 

Key Name Function

Exposure Mode Changes AEC, TEC, and Manual exposure modes.

Filter Changes the Filters.
The Filter options depend on the X-ray tube. The Molybdenum 
system has Mo and Rh. The Tungsten system has Rh and Ag.

kV Up Increases kV. 

kV Down Decreases kV. 

mAs Up Increases mAs.

mAs Down Decreases mAs. 

Grid Changes the Grid Position (In or Out).

Focal Spot Changes the Focal Spot size (Small or Large).

Breast Density Changes the TEC Breast Density settings.

AEC position Moves the AEC Sensor position.

New Entry Opens New Patient Entry dialog box.

Close 
Procedure

Closes the Procedure. (Disabled when MPPS is installed).
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4.6 The Selenia Display

Features  Display

Totoku Display

• Has a Power button (2)/On-screen Display 
Adjustment dial(1).

• Green indicator lights when Display is turned on.

• Has the ability to tilt.

Figure 2-13: Totoku Display

Barco Display

• Meets the DICOM requirements.

• Press the recessed dial (on the right side) to 
display a menu.

• Press and hold the recessed dial to turn the 
Display On/Off.

• Green indicator lights when Display is turned on.

• Has the ability to tilt.

• The Value Console uses only the Barco display. Figure 2-14: Barco Display
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5.0 TechMate Controls and Displays

Figure 2-15: TechMate Controls and Indicators

Legend for Figure 2-15
1. TechMate Display

2. TechMate Keyboard

3. TechMate Trackball

4. Power Button for TechMate

5. TechMate UPS Reset
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6.0 Tubestand Controls and Displays

6.1 Gantry Controls and Displays

Tubestand Components

1. The Gantry

2. The C-arm

Figure 2-16: Tubestand

Gantry Controls

1. The C-arm Rotation Angle Displays, on both sides of 
the Gantry, show the C-arm angle.

2. The Emergency Off Switches, on each side of the 
Gantry, remove power from the Tubestand.

3. Gantry Rotation Switches (if installed), on each side 
of the Gantry, move the C-arm to a programmed 
position. 

4. The Input Power Circuit Breaker, at the rear of the 
Gantry, provides the overload protection.

5. Dual-Function Footswitches activate C-arm and 
Compression Device movement.

Figure 2-17: Gantry Controls
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6.2 C-arm Controls and Displays

1. Tubehead Controls

2. Compression Device

3. Rear of the C-arm Side Rails

4. Rear of the Image Receptor

The Tubehead Controls, on either side of the X-ray tube side 
covers, provide the Collimator Override,      C-arm Rotation, 
and Light Field functions.

The Compression Device contains the AEC Sensor control 
and position LEDs, and displays compressed breast 
thickness and force. Handwheels allow manual 
compression control.

The rear edges of the C-arm Side Rail have recessed 
push-button controls for motorized compression and C-arm 
movement. An additional C-arm Rotation button is available 
on the rear of the Image Receptor.
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6.2.1 Compression Device Controls and Displays

6.3 Dual Function Footswitches

Warning: Put the footswitches where a patient user, or wheelchair cannot 
accidentally activate a switch.

Legend for Figure 2-18
1. Compression Handwheels

2. AEC Sensor Position controls

3. AEC Sensor Position Display

4. Compression Force Display 

5. Compression Thickness Display 

Figure 2-18: Compression Device

1
3

5
7

AUTO

AEC

NEWTONS / LBS

CM

AECPOSITION

1. Press the footswitch to activate.

2. Release the footswitch to stop 
motorized movement.

Legend for Figure 2-19
1. C-arm Down

2. C-arm Up

3. Compression Down

4. Compression Up

Figure 2-19: The Dual Function Footswitch

COMPRESSIONC-ARM
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Chapter 3 - Startup, Functional Tests, and Shutdown

1.0 Procedure for Startup

Table 3-1: System Startup Procedures

Step Description

1. Reset the Emergency Off Switches.

• Two on the Gantry

• One on the Acquisition 
Workstation (or Value Console)

Figure 3-1: Emergency Off Switch
2. Make sure that the circuit breakers 
are turned On.

Figure 3-2: Gantry Circuit Breakers

Figure 3-3: Acquisition Workstation Circuit Breaker
3. Perform Pre-Startup Checks. 1. Look for open or loose panels, missing hardware, and indications of 

damage.

2. Inspect the radiation shield for chips, cracks, breaks, and for tight 
attachment.

3. Inspect the paddles for small cracks.

4. Remove any obstructions to the Operator view and C-arm 
movement.

4. Turn On the Selenia. Turn on the 
TechMate.
(If the Acquisition Workstation or 
TechMate does not start, reset the 
UPS for that unit. See Section 4.3, 
page 30.)

Figure 3-4: Power On Buttons

1. Press the Power On button (No. 1). The green LED (No. 2) 
illuminates. 

2. Press the Power On button (No. 3) and the TechMate turns on.

3. Allow the time for initialization and diagnostic tests to complete.
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Note… If the system remains on over the night, reboot the system daily to 
resync system communications.

Note… If the system was turned off for 30 minutes or longer, the detector 
temperature needs time to adjust. Allow a minimum of 1 hour before 
you acquire images on a patient. The Launch dialog box disappears 
when the wait time is finished.

If it has been less than 30 minutes, click Dismiss in the Launch dialog 
box.

Note… If during the internal checks, the system detects a fault condition, a 
message appears, and startup is suspended until the problem is 
remedied.

5. Log on to the Operating System. When the Logon dialog box appears:

1. Enter your user name (case sensitive) for the Operating System. 

2. Select OK or press the Enter key.

3. Enter your Operating System password. (No characters appear in the 
field.)

4. Select OK or press the Enter key.
6. Log in to the Application. When the Login to System dialog box appears:

1. Select your ID from the drop-down list.

2. Enter your password (case sensitive). (Asterisks appear in the field.)

3. Select OK or press the Enter key.

Table 3-1: System Startup Procedures

Step Description
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2.0 Controls and Functional Tests
Perform these functional tests monthly.

Note… The C-arm movement is disabled when compression force of 58 N (13 
lb.) or greater is applied.

Table 3-2: Monthly Control Function Tests

Function Control Test

Counterclockwise C-arm 
Rotation

C-arm and Gantry Rotation 
Switches 

Press and hold the C-arm button and 
confirm the following actions:

• C-arm rotates

• Angle Display changes

• Rotation stops when you release 
the button.

Press and hold a Gentry 
Counterclockwise button and 
confirm the following actions:

• Beeps before the C-arm rotates

• C-arm counterclockwise 
movement stops when the pre-
programmed rotation angle is 
reached.

• Press and hold a Center button 
and confirm C-arm moves to 
zero degree position.

Clockwise C-arm Rotation C-arm and Gantry Rotation 
Switches 

Press the button and confirm the 
following actions:

• C-arm rotates

• Angle Display changes

• Rotation stops when you release 
the button.

• Press and hold a Gentry 
Clockwise button and confirm 
the following actions:

a. Beeps before the C-arm 
moves.

b. C-arm clockwise movement 
stops when the pre-
programmed rotation angle 
is reached.

• Press and hold a Center button 
and confirm C-arm moves to 
zero degree position.
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Compression Down 1. Press the button.

2. Confirm the compression brake 
engages and the light field lamp 
illuminates.

3. Confirm the Compression Down 
movement stops:

• When you release the button.

• At the compression down force 
limit.

• At the lower compression travel 
limit.

Compression Up 1. Press the button.

2. Confirm the compression brake 
does not release.

3. Confirm the Compression Up 
movement stops:

• When the Compression device 
reaches the upper compression 
travel limit.

• On release of the button.

Compression Release 1. Press the button.

2. Confirm the following actions:

• The compression motor brake 
releases.

• The compression device lifts 
approximately 10 cm.

Note... The system disables all 
compression release functions when 
a localization paddle is installed.

Table 3-2: Monthly Control Function Tests

Function Control Test
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C-arm Up 1. Press the button.

2. Confirm the C-arm Up 
movement stops:

a. When you release the 
button.

b. When the C-arm reaches 
the upper travel limit.

3. Apply more than 58 N (13 lb) 
compression and confirm the C-
arm does not move.

C-arm Down 1. Press the button.

2. Confirm the C-arm Down 
movement stops:

• When you release the button.

• When the C-arm reaches the 
lower travel limit.

Light Field Lamp 1. Press the button. Confirm the 
light turns on for a short time.

2. Confirm the light field lamp 
turns on when a Compression 
Down button is activated.

Table 3-2: Monthly Control Function Tests

Function Control Test
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Collimator Override 1. Press the light field button then 
the collimator button.

2. Confirm the Collimator moves to 
the next field size.

3. Repeat the steps 1 and 2 until 
you move through all Collimator 
field sizes.

Smart Paddle 1. Install a Smart Paddle.

2. Rotate and hold the knob on the 
side of the paddle to move the 
paddle into a detent positions.

3. Release the knob to lock the 
paddle in position.

4. Turn on the light field lamp.

5. Confirm the collimator position 
matches the paddle position.

6. Repeat this procedure for the 
other two paddle positions. 

7. Apply compression and confirm 
the paddle does not unlock.

AEC Position 1. Select an AEC mode. 

2. Change the AEC position with 
the compression device arrows.

3. Confirm the indicator positions 
on the sides of the device and 
Acquisition Workstation display 
match the current position.

4. Move past position 7 or 1. 

5. Confirm the Auto position 
indicator on the compression 
device illuminates and the 
display indicates Auto. 

6. Select the AEC arrows on the 
display and repeat steps 3 to 5.

7. Use the keyboard function key 
and repeat steps 3 to 5.

Table 3-2: Monthly Control Function Tests

Function Control Test
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3.0 Monthly System Tests
• Test all Emergency Stop Switches. Follow the on-screen reset procedure.

• Change the AEC Sensor Position switch, and make sure the compression device 
indicator and the Acquisition Workstation display change.

• Test all buttons on all keypads and footswitches. Include the compression release on the 
Acquisition Workstation.

• During Compression Device tests make sure the thickness and force displays change.

• During C-arm rotation tests, confirm that the LED Angle displays change.

4.0 How to Restart the System

4.1 Restart From Sleep Mode
1. To activate the system, move the trackball or mouse.

Figure 3-5: Operating System Login Screen

2. In the Login dialog box, enter reboot for the user name and password.

3. Wait for the system to restart. 

4. Log on to the Operating System, then Log on to the Application software.

5. If the system was off for less than 30 minutes, select Dismiss in the Launch dialog box. 

4.2 Restart After the Emergency Off Switch was Activated
1. Turn the Emergency Off switch by one-quarter turn clockwise to reset the switch.

2. When the Power Panel dialog box displays, “Communication with the generator is lost,” 
examine the Emergency Off Switches and the circuit breaker:

Caution: Do not try to close this dialog box using the ‘x’ in the upper corner.

3. When the “Link established with generator” dialog box appears, select OK.

• If the Gantry power is turned on, select the Cancel button.

• If the Gantry power is turned off, and the Emergency Off Switches and 
the circuit breaker are set correctly, select the OK button.
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4.3 How to Turn On or Reset the Uninterruptible Power Supply (UPS)

4.4 How to Turn Off the UPS
1. Make sure the Acquisition Workstation and TechMate or the Value Console are off. The 

UPS system begin to chirp repeatedly and can now be shut down.

2. Find the UPS switch. (See Figure 3-6 or Figure 3-7). 

3. For the Acquisition Workstation, press and hold the switch lever down for two seconds 
or until the UPS beeps. For the Value Console, press and hold the UPS switch for two 
seconds or until the UPS beeps.

4. For the TechMate, perform steps 1 and 2 in Section 4.5, page 31.

5. When the power is restored, press the UPS switch one time to turn on the UPS.

Figure 3-6: The Acquisition Workstation UPS 
Switch Lever

Figure 3-7: Value Console UPS Switch

1. Find the Acquisition Workstation UPS 
switch lever on the lower, right of the back 
panel.

2. Press the switch lever down and hold for 
two seconds or until the UPS beeps.

3. Start the Acquisition Workstation 
normally.

1. Find the Value Console UPS switch, on 
the front of the UPS.

2. Press and hold the UPS switch for two 
seconds or until the UPS beeps.

3. Start the Console normally.

LBL-00343

UPS
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4.5 UPS Operation for TechMate
To reset the TechMate UPS:

Figure 3-8: Reset the TechMate UPS

1. Find the UPS access hole in the middle of the left side of the front cover. This hole aligns 
with the Power button on the UPS.

2. Put the eraser-end of a pencil into the hole to press the UPS button until the UPS beeps.

3. Press the button again and listen for a second beep.

4. Start the TechMate normally.

To turn off the TechMate UPS, follow steps 1and 2.

UPS
LBL-00343
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5.0 How to Log Out
There are two methods to log out of the application. This leaves the system on and another 
user can log in to use it.

6.0 How to Shut Down the System
1. Select File>Exit.

2. Select Power off the computer? from the Exit from acq. station dialog box. 
See Figure 3-10.

3. Select Yes.

Note… If a message appears and indicates that there are spool jobs, select log 
off or wait until the jobs are finished. (The spool continues again later.) 
Hologic recommends that you allow the jobs to complete before shut 
down.

Caution: Do not use a Circuit Breaker or Emergency Off switch as a routine 
method to turn off the Selenia.

Caution: Never turn off the Acquisition Workstation or Value Console Circuit 
Breaker except in emergency. The circuit breaker turns off the 
Uninterruptible Power Supply (UPS) and risks data loss.

Table 3-3: The Log Out Methods

Method 1 Method 2

1. Select the Sign Out button.

Figure 3-9: The Sign Out Button

2. Select the Exit button.

3. Select Yes.

1. Select File>Exit.

2. Select Log out of the computer?.

Figure 3-10: Exit from Acquisition Workstation 
Dialog Box

3. Select Yes.
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Chapter 4 - The Selenia Accessories

1.0 Introduction
Available accessories depend on your system configuration. Selenia performs screening and 
diagnostic applications. The Selenia S system performs only screening applications.

Note… On the Selenia S system, only use the 7.5 cm Spot Contact Paddle for 
compression thickness calibration.

Table 4-1: Available Accessories

Accessory Selenia Selenia S

Routine Screening Paddles 18 x 24 cm * *
18 x 24 cm FAST * *
24 x 30 cm * *
24 x 30 FAST * *
Small Breast * *

Contact and Spot Compression 10 cm Contact *
Paddles 15 cm Contact *

Ultrasound *
7.5 cm Spot Contact * See Note
Frameless Spot *

Magnification Paddles 7.5 cm Spot *
10 cm *
15 cm *
10 cm Mag Localization *
10 cm Mag Perforated Localization *

Localization Paddles 10 cm Perforated *
15 cm Perforated *
10 cm Rectangular Open *
15 cm Rectangular Open *

Patient Face Shield * *
Magnification Platform *
Localization Crosshair Device *
Magnification Crosshair Device *
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2.0 Patient Face Shield
Remember to examine the Face Shield condition before use each day.

2.1 How to Install the Face Shield on the Tubehead
1. Put the tab ends on the open end of the Face Shield into the slots on the tubehead 

mount.

2. Slide the Face Shield into the tubehead mount until the Face Shield locks in position.

2.2 How to Remove the Face Shield
1. Pull the rear sides of the shield away from the tubehead.

2. Slide the shield off the mount.

Figure 4-1: Installation of the Face Shield

Warning: Except for magnification case studies, always use the Face 
Shield.

Warning: The Face Shield does not protect from radiation.
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3.0 Compression Paddles
There are 19 compression paddles for Screening and Diagnostic Procedures. 12 of the 19 
paddles are Smart Paddles and have mechanisms that allow manual lateral movement (both 
left and right). The x-ray collimation moves with the Shifting Compression Paddle position. 
The other seven paddles include five magnification paddles and two large, 24 x 30 cm 
paddles.

3.1 How to Install the Compression Paddles
1. Align the mounting pins on the rear frame of the paddle with the mounting holes in the 

Compression Device.

2. Push the compression paddle into the Compression Device until the paddle stops.

3. Carefully pull the paddle out approximately 3 mm until the paddle clicks into position.

3.2 How to Remove a Compression Paddle
1. Hold the paddle by the metal sides of the frame.

2. Pull the paddle in a straight line from the mounting holes.

Figure 4-2: Mount the Compression Paddle

3.3 Maintenance and Cleaning
Clean the paddles after each use. Refer to Chapter 9, page 95, for cleaning instructions.
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3.4 Smart Paddle System
A release knob on each side of the Smart Paddle allows it to move from one side of the image 
detector to the other. This enables the Technologist to optimize the breast position and 
imaging within the active area of the Image Receptor, especially when Lateral Views of a 
small breast are required.

To shift a Smart paddle:

3.5 FAST Paddle Use
The Fully Automatic Self-adjusting Tilt (FAST) Paddle is for use when the composition of the 
breast tissue does not allow uniform compression across the complete breast with a flat 
compression paddle. For these patients, not enough compression can cause an image to 
appear to be out of focus at the anterior region from both involuntary motion and not enough 
compression. 

The FAST paddle use with this type of breast provides these features:

• Reduced motion artifacts, because the compression is more effective.

• The compression is more uniform from the chest wall to the nipple.

• Maximum patient comfort, because over compression at the chest wall is prevented.

The FAST paddle automatically tilts when the compression is applied. The paddle is in a flat 
position until a compression force of approximately 20 pounds (88 Newtons) is applied. The 
paddle then tilts until its maximum angle is reached at a force of approximately 30 pounds 
(132 Newtons). 

The FAST paddle does not require excessive compression, but you must use enough 
compression to prevent the movement of the breast. You should use a consistent amount of 
compression, especially for related left and right views.

The FAST paddle may not be best for breasts that are equal or symmetrical in thickness from 
the chest wall to the anterior area of the breast.

1. Select a View on the Acquisition 
Workstation.

2. Rotate the release knob on the side 
of the paddle from the lock to the 
shift position.

3. While you hold the knob in the shift 
position, move the paddle to match 
the View. The paddle locks into 
position on a detent.

4. Release the knob to lock it in 
position. 

5. Confirm the paddle is locked into 
position.

6. Activate the light field lamp and 
confirm the collimator matches the 
paddle position.

Figure 4-3: Shifting Compression Paddle
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3.6 How to Realign the Paddle Front Edge

1. Install the paddle and apply 30 lb (132 N) of 
compression force.

2. Make sure that the front edge is aligned to the front 
edge of the Image Receptor. See Figure 4-4.

To align the edge when it is not aligned as shown in 
Figure 4-4:

1. Release the compression and remove the paddle.

2. Loosen the hardware that holds the paddle to the 
frame. On a standard screening paddle, or a frameless 
spot paddle, turn the paddle upside down and loosen 
the hardware one complete turn. On a FAST paddle, 
use a hex wrench to loosen the paddle.

3. Turn the paddle over (if necessary) and loosen the two 
inside screws. See Figure 4-5.

4. Install the paddle and apply 30 lb (132 N) of 
compression force.

5. Move the paddle to the correct position. (Do not 
release the compression.)

6. Tighten both inside screws. See Figure 4-5. 

7. Release the compression and remove the paddle.

8. Turn the standard screening or the frameless spot 
paddle upside down and tighten the hardware that 
fastens the plastic paddle to the frame.

9. Install the paddle and apply 30 lb (132 N) of 
compression force.

10. Confirm that the front edge of the paddle is aligned to 
the front edge of the Image Receptor.

Figure 4-4: Alignment of the 
Paddle

Figure 4-5: Alignment of 
Adjustment Screws
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3.7 Identification of Compression Paddles

3.7.1 Routine Screening Paddles

3.7.2 Contact and Spot Compression Paddles

18 x 24 cm Screening Paddle 18 x 24 cm FAST Paddle

24 x 30 cm Screening Paddle 24 x 30 cm FAST Paddle
Small Breast Paddle

10 cm Contact Paddle 
15 cm Contact Paddle Ultrasound Paddle

7.5 cm Spot Contact Paddle Frameless Spot Paddle 
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3.7.3 Magnification Paddles

Use the Magnification paddles when the Magnification Platform is installed.

3.7.4 Localization Paddles

3.7.5 About the Localization Paddles

The Installation method is the same for all Paddles. The system locks out Auto 
Compression Release when a Localization Paddle is installed. The AEC Sensor may 
require repositioning.

7.5 cm Spot Magnification 
Paddle

10 cm Magnification 
Paddle 15 cm Magnification 

Paddle

10 cm Magnification 
Localization Paddle

10 cm Magnification 
Perforated Localization 
Paddle

10 cm Perforated Localization Paddle 10 cm Rectangular Open Localization Paddle 

15 cm Perforated Localization Paddle 15 cm Rectangular Open Localization Paddle 

A
A
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4.0 Magnification Platform
When the Magnification Platform is installed, the HTC grid automatically retracts and the 
default values for Magnification x-ray exposure techniques are set.

4.1 How to Install the Magnification Platform
1. Remove the Face Shield (refer to Section 2.0, page 34).

2. Remove the compression paddle.

3. Move the Compression Device above the slots in the C-arm.

4. Hold the Magnification Platform by the support brackets and align the hooks of the 
bracket with the mounting slots on the C-arm.

5. Put the hooks into the C-arm slots.

6. Push the frame down so that the clips lock the Platform in position.

When the platform is installed, you can use only the Magnification paddles. (See 
Section 3.7.3, page 39)

4.2 How to Remove the Magnification Platform
1. Remove the Magnification paddle.

2. Press the locking clips on the Magnification Platform down to release the hooks.

3. Lift the Magnification Platform up and out by the support bracket.

4. Reinstall the Face Shield.

Figure 4-6: Magnification Platform Installation
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5.0 The Localization Crosshair Device
The Localization Crosshair device, used with a localization paddle enables the location of a 
specified spot on the breast. 

5.1 How to Install the Crosshair Device

Figure 4-7: Installation of the Crosshair Device

1. Remove the Face Shield from the tubehead.

2. Move the Compression Device below the C-arm mounting slots.

3. Hold the Crosshair device by the support brackets and slide the hooks into the C-arm 
slots.

4. Push the device down to the locked position.

5. Install the Localization paddle on the Compression Device.

5.2 How to Remove the Crosshair Device

1. Rotate the Crosshair device to the left or 
right.

2. Press the two locking levers inside each 
mounting arm. See Figure 4-8.

3. Lift the device up and from the C-arm.  
Be careful. The device is top heavy.

4. Install the Face Shield.

Figure 4-8: Crosshair Locking Levers
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5.3 Localization Crosshair Device to the Localization Paddle Alignment

Note… Before you perform the following adjustment, make sure the 
Localization paddle is aligned to the edge of the image receptor. Refer 
to “How to Realign the Paddle Front Edge,” page 37.

6.0 The Magnification Crosshair Device

Figure 4-10: Installation of the Magnification Crosshair Device

1. Remove the face shield from the tubehead.

2. Align the Magnification Crosshair Device with the grooves of the face shield rails.

3. Push forward until the device locks into position.

4. To remove the Magnification Crosshair Device, pull and slide the assembly toward you.

1. Install a rectangular localization paddle.

2. Loosen the adjustment lock screw on the 
bottom of the Crosshair Device. See 
Figure 4-9 No. 1.

3. Put a piece of white paper on the breast 
tray so that you can see the shadows of 
the crosshairs.

4. Move the Localization paddle 
approximately 6 cm above the image 
receptor.

5. Turn on the light field.

6. Move the Crosshair Device until the 
rectangle of light aligns with the opening 
in the localization paddle.

7. Tighten the adjustment screw. Figure 4-9: Adjustment Lock Screw 
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Chapter 5 - The User Interface

1.0 The Three Main User Interface Screens
The process of image acquisition, enhancement, and output is done through three screens: 

• Select a Patient screen

• Patient Views screen

• Preview Images screen

When you select an option on a screen, other screens may appear for information entry or 
selection of additional options. This manual covers the screens that appear while you are 
logged in as a “tech”.

• Select a Patient

• Patient Views

• Preview Image 
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2.0 A Screening Exam Sequence Suggestion

Table 5-1: Workflow Suggestions to Select a Patient and Acquire an Image

Action What it looks like

1. Start up the system and log in to Operating 
System and Application. Refer to Chapter 3, 
page 24 

 

Technician, Manager, or Physicist
2. Select the patient.

• Query the MWL

a. Select Worklist tab in upper left of screen.

b. Use the Bar Code Scanner to input query 
data, then select Query, or enter the query 
data then select the Enter key.

c. Select the patient from the list.

• Search the local database

a. Select the Local Exams tab in the upper 
left of the screen.

b. Select the Patient Name tab (or ID tab) 
then enter the data.

c. Select the Search button. See Chapter 6, 
Section 2.3, page 48 for information about 
wildcard searches.

d. Select the patient from the list.

• Add a New Patient

a. Select New from the Patient area of the 
screen.

b. Enter the required information.

c. Select the Accept button.
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3. Select the Procedure, when more than one is 
scheduled.

• Select from the scheduled procedures list. 

a. Find the procedure in the list.

b. Double-click the Select button.

• Add a procedure

a. Select New in the Procedure area.

b. Select the procedure from the list.

c. Select the Accept button.

4. Edit the patient Information, if necessary

a. Select the patient from the patient list.

b. Select Edit from the Patient area.

c. Make the changes in the Edit Patient 
screen.

d. Select the Accept button.

5. Install the accessories. See Chapter 4, page 33 
for installation, removal, and alignment procedures 
for each device.

• Face Shield

• Compression Paddle

• Magnification Platform

• Crosshair
6. Select the view.

• Use the default view sequence.

a. Acquire the selected view.

b. Acquire an image for each of the 
remaining views.

• Select another view from the displayed views.

a. Select any view displayed on the Patient 
View screen.

b. Acquire the selected view.

c. Repeat for the remaining views.

• Add a view.

a. Click Add View in the Patient View screen. 

b. In the dialog box, select a view from the 
list of Standard Mammography Views. To 
add many views, press and hold the 
Control key and select the views.

c. Select the OK button.

Table 5-1: Workflow Suggestions to Select a Patient and Acquire an Image

Action What it looks like
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7. Select the Exposure Techniques.

• Use default values for selected exposure 
mode.

a. Select the Exposure Mode.

b. Make sure the default settings are correct 
for the exam/patient.

• Change default values for the selected 
exposure mode.

a. Select the Exposure Mode.

b. Adjust the default values.
8. Position the system and Patient.

a. Adjust the vertical height of the Breast 
Platform.

b. Set the C-arm angle.

c. Put the arm and hand of the patient in a 
safe location.

d. Compress the breast.
9. Acquire the image.

a. Make sure the message area of the screen 
displays “Ready” (1) and there is no “X” 
through the x-ray indicator (2).

b. Press and hold the x-ray buttons.

c. Inspect the image on the Preview Screen 
then select the Accept or Reject button.

10. Close the procedure.

a. Select the Close Procedure button.

b. Select the Yes button.

Table 5-1: Workflow Suggestions to Select a Patient and Acquire an Image

Action What it looks like
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Chapter 6 - The Select a Patient Screen

1.0 Introduction
The Select a Patient screen appears when the system application loads. This screen allows 
you to locate a patient, and access non-routine Acquisition Workstation options with no 
patient selected.

Figure 6-1: The Select a Patient Screen

Table 6-1: Legend for Figure 6-1

1.  Menu Bar Section 8.0, page 59.
2.  Search for a Patient Section 2.0, page 48.
3.  Patient Query Section 2.2, page 48.
4.  Today’s Worklist Section 2.3, page 48
5.  Exposure Techniques Section 7.0, page 54.
6.  Add/Edit the Patient Information Section 3.0, page 49.
7.  Add/Edit a Procedure Section 5.0, page 51.
8.  Outputs Section 6.0, page 53.
9.  Special Modes Section 9.0, page 72.
10. Generator Status Section 10.0, page 73.
11. System Message Section 11.0, page 73.
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2.0 Select a Patient
A patient can be added to the system or already exist and be selected from a list. There are 
two places to search for an existing patient, the worklist which is a list of scheduled patients 
from a Modality Worklist Provider and the Local Exams which are the patients on the 
computer in the workstation.

2.1 How to Query the Modality Worklist Provider
1. Select the Worklist tab in the upper, left area of the Select a Patient screen.

2. Input the query information with the Bar Code Scanner or the Keyboard.

3. Select the Query button or press the Enter key.

Note… This query does not search the local Acquisition Workstation database, 
Local Exams. An Asterisk is not required for this search.

4. If you changed the date from the ‘today’ setting, select the Today’s 
Worklist tab.

5. Select the patient from the list to open their procedure. 

If your search for one match with a Patient ID or Accession Number has results, the patient 
Procedure opens automatically. Selecting a patient adds them to the Local Exams database. 

2.2 How to Search the Acquisition Workstation Database (Local Exams)
1. Select the Local Exams tab in the upper, left area of the Select a Patient screen.

2. Select the Patient Name or ID tab. 

3. Enter the Patient Name or ID in the Search box. Or, enter part of a Patient Name or part 
of an ID number and use an asterisk for the missing characters.

4. Select the Search button or press the Enter key.

2.3 More Information about Searches
• When part of the patient name is entered, the system applies a wildcard character at the 

end of the name.

Note… You can use the asterisk (*) as a wildcard character to increase your 
search. For example, when you enter R*ph, Patients with the names 
Randolph and Rudolph will display. If you use a wildcard character, 
make sure that you include a minimum of one other character.

• You can use one or more of the search fields.

• You can limit the query to a date range.

• Most worklist providers require information in the Patient ID and Accession Number 
fields to match. Data in these fields is case sensitive.

• You must include the caret (^) character between the name parts (for example, DOE^J).
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3.0 How to Add a New Patient
The Patient area of the screen allows you to Add a New Patient and Edit the existing patient 
information.

1. Select New in the Patient pane to display the New Patient Entry dialog box.

Figure 6-2: New Patient Entry Form

2. Enter the Patient demographic information. Use the Tab key or the trackball to move 
through the fields. You must enter information in the Fields that have an asterisk. 

• The Patient Name fields must contain only letters or numbers.

• The Clear button clears the information you entered. 

• The Cancel button closes the form without your changes.

3. Select the Accept button to enter the Patient in the Acquisition Workstation Local 
Database. (This new information is not sent to the PACS system.) The Patient Views 
screen displays.

Warning: Verify the Patient Demographic Application information before 
you acquire an image.
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4.0 How to Edit the Existing Patient Data

Figure 6-3: The Edit Patient Dialog Box

Note… This procedure only changes the patient information for images in the 
case study not yet taken. The Acquired images must be resent using 
Image Management and Resend, after the information is edited. Refer 
to Section 8.2.1, page 65.

Caution: Do not edit the patient information if you use a Modality Worklist. See 
Section 4.1, page 50

To edit the Patient information:

1. Select Edit in the Patient Box to display the Edit Patient dialog box.

2. Make the changes to the fields that have wrong or missing information. Use the Tab key 
or the trackball to move through the fields.

Note… The Cancel button closes the dialog box without any changes. The 
Clear button clears last name, first name, DOB, and age.

3. Select the Accept button.

4. Verify that the correct changes appear in the screen before you acquire a new image.

4.1 About Patient Information Edits with a Modality Worklist and PACS
• Make the patient information changes on the HIS/RIS before any information is sent to 

the Selenia. 

• Make the patient information changes on the PACS if the images were sent to the 
Selenia.

• Any patient information changes on the Selenia must be a last option. Some RIS systems 
do not have the ability to change this information at the Selenia.

• The Modality Worklists transfer the Patient Information from a HIS/RIS system to the 
Selenia. Any change on the Selenia to this information can cause a mismatch of 
information when the Selenia images are sent to PACS. Work with your HIS/RIS 
administrator before you make any changes on the Selenia to the patient information.

4.2 How to Change the Patient Information After an Image Is Accepted
When an image is accepted, the image is immediately sent to the output. If the related 
information requires any change, then repreview, save, and resend the image as an 
additional record and delete the previous record. 
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Remove any wrong images from:

• Printer

• Diagnostic Review Workstation

• PACS

Correct the information at the AWS:

1. Select the Local Exams tab and search for the patient.

• If patient information is wrong, select Edit in the Patient Pane.

• If the accession number is wrong, select Edit in the Procedure pane.

2. Change the wrong patient information.

3. Select the Accept button.

4. Select the Close Procedure button.

5. Select Admin>Image Mgt.

6. Search for the patient.

7. Select the Repreview tab.

8. Select the first thumbnail image.

9. Select the Repreview button.

10. Select the Save button.

11. Repeat the steps 10 to 12 for the remaining images in the procedure. Eight thumbnail 
images display (if there were four in the original procedure.)

12. Select the last four thumbnail images (the corrected views).

13. Select Resend to all required outputs.

14. After you confirm that the four images were resent, have a manager delete the four 
images with the wrong labels.

5.0 New, Edit, Add a Procedure

5.1 How to Add a New Procedure
1. Retrieve the existing Patient. 

2. Select New in the Procedure pane. 

Figure 6-4: New Procedure, Edit a Procedure, and Add a Procedure Buttons

3. Select Yes in the Creating a New Procedure will close the current Procedure dialog 
box. Any open procedure will close.

4. When the New Procedure dialog box appears, enter a new Accession Number.
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Figure 6-5: New Procedure Dialog Box

Note… The Cancel button closes the dialog box without any changes. The 
Clear button clears the Accession number.

5. Select the Procedure Description from the drop down list.

6. Select the Accept button.

7. Select Close in the Patient area.

5.2 How to Edit a Procedure
1. Select the Edit button in the Procedure area of the screen.

2. Change the Accession Number. You cannot change the Procedure selection.

3. Select the Accept button.

5.3 How to Add a Procedure
The Add a Procedure function allows you to have many Procedures open at the same time.

1. Select the Add button in the Procedure pane.

Figure 6-6: Add a New Procedure Dialog Box

Note… The added procedure must use the same Accession Number as the 
open procedure. If you do not plan to use the same Accession Number, 
select the New button and follow Section 5.1, page 51.

2. From the drop-down list, select the Procedure to add.

3. Select the Accept button. 
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6.0 Image Output

Figure 6-7: Select the Output

Before acquiring an Image, verify that you selected the correct output. All real patient images 
must be printed or committed to a PACS. Select the Output group to use for this procedure 
from the drop down list. To edit existing or create new output groups, refer to Section 8.1.5, 
page 63.

There is also a statement of the current number of Jobs in the Queue.
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7.0 Exposure Information

7.1 The Exposure Pane

Figure 6-8: Exposure Techniques

The top, left side displays the status of these options:

• Compression Force Mode

• Compression Release

• Compression Thickness

• Collimation Mode

• Collimation Size

• Image Size

• Paddle ID (type and position)

Select the Exposure Techniques in the bottom area. Use the up/down arrows in the Exposure 
Mode area (the lower, far-left box) to select the Exposure Mode. The exposure default values 
for that mode appear to the right. 
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7.2 About Exposure Modes

Note… When you change the mode, all Exposure Techniques reset to the 
default values for that mode.

7.2.1 About the Manual Exposure Mode

In the Manual mode the Operator sets all Exposure Techniques. The default values 
appear when you select the View, then you make any necessary adjustment.

• To change an Exposure technique with the trackball, scroll to the value with the 
up/down arrows, or select the option box. 

• To change an Exposure technique with the keyboard, press the Function Key for 
the item at the top of the keyboard. 

Table 6-2: Exposure Modes

Exposure 
Modes (#1)

Operator Adjustments Where the function is in the Techniques Pane

Auto-Filter Select the AEC 
Exposure (#2); AEC 
Sensor (#3) (Positions 
1-7 or Auto).

Auto-kV Select AEC Exposure; 
AEC Sensor.

Auto-Time Select kV; Filter; AEC 
Exposure; AEC Sensor.

TEC Select Breast 
Density (#4), then 
select Accept or 
change the Exposure 
Techniques, which puts 
you in Override 
(Manual) Mode.

Manual Manually calculate 
and select all x-ray 
techniques and 
Exposure Factors (kV, 
Filter, and mAs).
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7.2.2 About the TEC Exposure Mode

The Tissue Exposure Control (TEC) Mode is an enhanced Manual Exposure Control 
mode. 

1. Before you position and compress the breast, select the Breast Density type on 
the Acquisition Workstation screen or press the Breast Density key.

Figure 6-9: Breast Density Options

2. Compress the breast. The X-ray Exposure Techniques for kV, mAs, and filter 
update.

3. Select the Accept button in the Breast Density area (or press the Enter key). 
When “Ready” displays in the Generator Status message area, the system is 
ready to acquire an image.

Figure 6-10: Accept TEC Exposure Techniques

If you change one or more of the parameters (kV, mAs, or filter), the system enters 
the Override Mode. When the Override message displays, the system is ready to 
acquire an image.



Part Number MAN-01384 57

Instructions for Use
Chapter 6 - The Select a Patient Screen

Exposure Information

Figure 6-11: The Override Mode

There are three methods to exit the Override Mode and return to TEC mode: 

• Change the Breast Density setting.

• Release the compression then compress the breast.

• Select TEC mode a second time.

7.2.3 AEC Exposure Mode

The Automatic Exposure Mode (AEC) uses the pre-exposure Scout pulse, and for 
some modes the compression thickness to calculate the exposure.

The AEC options are Auto-Filter, Auto-kV, and Auto-Time. See Section 7.2, page 55 
for the exposure technique selections available with each mode.

7.2.4 AEC Exposure Adjustment Settings

You can use the Exposure Adjustment Settings to increase or decrease the target 
pixel value. Each step changes the target pixel value by approximately 15% and 
makes a related change in dose. See Figure 6-12, page 58.

Set this control in a range from +4 to -3 to increase or decrease the exposure. This 
adjustment setting remains until you change the setting or restart the system.

Warning: You increase the patient dose to high levels if you increase the 
AEC exposure adjustment setting. You increase the image noise 
or decrease image quality if you decrease the AEC exposure 
adjustment setting.

Warning: Increased Exposure adjustment leads to higher dose to the 
patient. Keep the patient dose as low as practical to get good 
image quality.
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Figure 6-12: AEC Exposure and Sensor Position Adjustment On-Screen Settings

7.2.5 AEC Sensor Position Indicator Settings

Select one of the seven positions to indicate the area of interest for AEC calculations. 
Or, select Auto AEC where a larger area is tested.

Note… Always confirm the position of the AEC Sensor before an AEC exposure.

The AEC Sensor Position has eight available positions.

• The Positions 1 through 7 are manually selected, from the chest wall edge 
(position 1) to the nipple edge (position 7).

• Position 8 (Auto) automatically positions the sensor.

To change the AEC Position selection, use:

• The buttons on the compression device.

• The AEC Pos key on the keyboard.

• The AEC position arrows on the Acquisition Workstation display.

Set the AEC Sensor Position after you compress the breast. The displays on the side 
of the Compression Device and the lower right corner of the screen indicate the 
position setting.

7.2.6 AEC Alarm Messages

When the system cannot use the selected AEC mode to acquire an Image, one of the 
following messages displays.

1. Select OK in the dialog box.

2. Select the Reset Generator button.

Table 6-3: AEC Alarm Messages

Message Reason and Corrective Action

Calculated Exposure Time 
Less Than Min

The AEC Sensor is over a thin or small area of breast 
tissue. Use the AEC Sensor in a position under the 
breast tissue. Alternately, use AutoTime and a lower kV.

Calculated Exposure Time 
Exceeds Max

Very dense breast tissue, an implant, pacemaker, or 
other anatomy changed the AEC sensor. Move the 
manual AEC sensor where there are no obstructions. 
Alternately, use AutoTime and a higher kV.
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8.0 Menu Bar
The Menu Bar provides easy access to non-routine Acquisition Workstation options. These 
options are available while the Acquisition Workstation application runs unless a dialog box 
or Procedure is opened.

The table below shows the Menu Bar options when a patient procedure is not selected.

Table 6-4: Menu Bar Options and Functions

Menu Options Function

File Exit Exit from Acquisition Workstation
Edit Standard Setup Select the startup default values. (Section 8.1.1, 

page 60)
View Order Editor Change the view order. (Section 8.1.3, page 61
User Setup Add, edit, delete a user profile. (Section 8.1.4, 

page 62)
Outputs Add, remove output devices. (Section 8.1.5, 

page 63)
Admin Image Management Retrieve the images from the image spool. 

(Section 8.2.1, page 65)
Protect Patients Protect or Unprotect patient records. 

(Section 8.2.4, page 67)
Manage Queues Find a specified job in the queue. 

(Section 8.2.5, page 68)
Eject Remove a disk from CD/DVD drive. 

(Section 8.2.6, page 69)
Import Copy images from a CD to the system. 

(Section 8.2.7, page 69)
Retrieve Priors View previously-acquired images. 

(Section 8.2.8, page 70)
PPS Status* Additional options (when MPPS Service is 

installed) for close of a procedure. 
(Section 8.2.9, page 70)

Calibrate Access calibration procedures. (Section 8.2.10, 
page 70)

Test Patterns Access test pattern procedures. (Section 8.2.11, 
page 71)

DR Device Control Access by Service personnel. (Section 8.2.12, 
page 71)

Available Disk Space Displays status of hard disk drive space. 
(Section 8.2.13, page 72)

Stereotactic** En/Disable Stereo mode** Engage or disengage the stereo mode. Available 
when the StereoLoc II is installed.

Info About the Acquisition 
Workstation

(Section 8.3, page 72)

* This option appears when the MPPS Service is installed.
** This option appears when the Stereotactic Service is installed.
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8.1 Edit Menu Function

8.1.1 Standard Setup Screens

Figure 6-13: The Setup Screen

1. Select Edit>Standard Setup.

2. Use the trackball or the keyboard Tab key to move between fields.

3. Use the trackball or arrow keys to display and select options. 

4. Select the Close button to exit the dialog box.

Note… When Manual Collimation is selected, the function that automatically 
changes the Collimation when a paddle is changed or moved turns off.

8.1.2 Set Technique Defaults

Select the Set Technique Defaults button to display the Technique Default Setup 
screen. You must set the default values for all modes.

1. Select Manual Exposure Mode and select the system startup defaults.

2. Change the mode to Auto-time and select the options.

3. Continue to change the mode and select the options for all remaining exposure 
modes including Magnification modes.
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8.1.3 View Order Editor

Figure 6-14: View Order Editor

1. Select Edit>View Order Editor.

2. Select the procedure from the drop-down menus.

3. Select the Views for each Procedure:

4. Move the View icons to change the order.

5. Select Close. Your view order preferences load when you log in.
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8.1.4 Add or Edit a User

A signed-in user can add or delete a user at the same or lower level. To access the 
Edit User options, select Edit>User Setup.

Figure 6-15: The Edit Users Dialog Box

Table 6-5: User Setup Options

Option Steps

• Add a new user 1. Select New.

2. Enter the requested information. The password must 
contain a minimum of 6 characters.

3. Select the Accept button.
• Edit a user 1. Select your name from the list. 

2. Select Edit.

3. Change the Initials, if necessary. 

4. If requested, enter the Password. The password must 
contain a minimum of 6 characters. 

5. Select the Accept button. 
• Delete a user 1. Select the User to delete.

2. Select the Delete button.

3. Select the Yes button to the confirmation prompt.
• Close the dialog box Select the OK button to close the Edit Users dialog box.
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8.1.5 Outputs

To Add New Output Groups:

1. Select Edit > Outputs.

2. Select New.

3. Enter the name for this Output.

4. Select OK.

5. Select the new name in the Edit Outputs dialog box. 

6. Select Edit.

Figure 6-16: Edit Output Device Dialog Box

Note… Outputs are first created during installation.

7. Select the tab for the type of device.

• CDRW = CD-RW

• Laser Camera = Printer

• Physician Display = Diagnostic Review Workstation, Technologist Review 
Workstation, CAD, etc.

• Archive = PACS

8. Select the device name.

9. Select the Add button to move it to the right column.

10. To add another output device to the new group, select the tab for the device type.

11. Select the device name.

12. Select the Add button.

13. Select the Accept button when finished with the group.

14. Select the OK button.
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To Edit Outputs:

1. Select Edit > Outputs.

2. Select an Output name. If the Output keeps its current name, go to step 7.

3. Select the Copy button.

4. Enter a new Output name.

5. Select the OK button.

6. Select the new name in the Edit Outputs dialog box. 

7. Select the Edit button.

8. Select the tab for the type of device to add.

9. Select the device to add.

10. Select the Add button to move it to the right column.

11. Select the name of any output in the Devices currently selected column that is 
not needed in the group.

12. Select the Remove Item button.

13. Select the Accept button.

14. Select the OK button.
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8.2 Admin Menu

8.2.1 Image Management

1. Select Admin>Image Management. The Choose a New Patient dialog box appears.

Figure 6-17: Choose a New Patient Dialog Box

2. Select the Patient Name tab or the Patient ID tab.

3. Enter the search information in the Enter Patient Name or ID box.

4. Select the Search button.

5. Select a patient from the list.

6. Select the thumbnail image of the image to resend or repreview. 

• You can select more than one to resend. 

• If there are more than four images, use the arrows on the side to scroll.

7. Select the Tab for Repreview or Resend.

8. Continue with directions in “The Resend Options,” page 66 or “The Repreview 
Option,” page 67.

Note… If the commit function is enabled and archive has committed the image 
to storage, the line “Commit: Accepted” appears in the information 
about the image in the upper right pane. See Figure 6-18.
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8.2.2 The Resend Options

Figure 6-18: Image Management Resend Options

1. Select the resend button.

• To resend all images on the hard disk drive for this patient, select Resend All 
Images.

• To resend selected images, select the thumbnails of the images to resend, 
then select the Resend Selected button.

2. Select the Output from the drop-down list.

3. If the selected Output has a printer, select the Print Image Processing Options.

4. Select the Resend button.

5. Select the OK button.

Note… You cannot change any Patient or image object information from the 
resend function. This includes image, LUT modifications and DICOM 
information such as Patient name spelling, ID, and comments. To send 
new information you must make a new file with the Repreview 
function, save it, and Resend the new file. 



Part Number MAN-01384 67

Instructions for Use
Chapter 6 - The Select a Patient Screen

Menu Bar

8.2.3 The Repreview Option

1. Select the thumbnail image to review.

2. Select the Repreview tab, then select the Repreview button.

3. When you finish reviewing, select the Cancel button.

4. To create a new file to resend, make any required changes to the markers, 
comments, or use the Edit View function, then click Save. If you select a FOR 
PRESENTATION image, you cannot change the markers and ROI is not enabled.

5. Make any necessary changes in the Contrast or Density. These changes do not 
save when you save the image.

6. Select the Save button.

Note… Make sure that you send the newly-saved image. The original is a 
possible selection.

8.2.4 Protect Patients

Use the Protect function to prevent automatic removal of patient records from the hard drive.

1. Select Admin>Protect Patients.

2. Search for the Patient to protect.

3. Select the Patient to protect from the search results. 

4. Select the Protect button at the bottom of the screen. 

5. When the confirmation dialog box appears, select the Yes button.

6. Select the Close button.

Note… To create more space on the hard disk drive, unprotect patients who do 
not need protection.

To unprotect a patient record:

1. Select the patient. 

2. Select the Unprotect button.
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8.2.5 Manage Queues

Use Manage Queues to find problem jobs or a specified job in the queues. 

Warning: If you select Delete Job, you cannot undo the deletion. If it still 
needs to be sent, resend the job to a storage device later.

Figure 6-19: Manage Queues

Legend for Figure 6-19

1. View the list of available queues.
2. Enable or disable a job spooler.
3. Update the list of Queued Jobs.
4. View the list of the jobs in the queue.
5. Remove inactive jobs from the queue. Resend stopped jobs.

Table 6-6: How to Use Manage Queues

Option Steps

• To find the status of a job: 1. In the Devices list, select the queue to view. 

2. Select the OK button.
• To delete a job: 1. Select the queue in the Devices list.

2. Select the Suspend <name> Spooler button.

3. Select a job from the Queued Jobs list, or Ctrl+click to 
select many jobs.

4. Verify that the selected job is the job to delete. There is 
no “undo”.

5. Select the Delete From Queue button.

6. Select the OK button.
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8.2.6 Eject

Select Admin>Eject to open the CD-RW drive drawer when there is a CD in the CD-
RW drive.

Note… When the CD-RW drive is empty, press the button on the CD-RW drive 
to open the drawer.

When there is a disk in the drive, the drive drawer opens only from the 
menu. To close the drive drawer, press the CD-RW drive button.

8.2.7 Import

To import the information from a CD:

1. Open the CD-RW drive drawer. 

• Press the CD-RW drive button to open the tray if there is no CD in the drive.

• Select Admin>Eject to open the drive if there is a CD in the drive. 

2. Put the CD that contains the images to import on the tray. 

3. Press the CD-RW drive button to close the tray. 

4. Select Admin>Import.

5. In the dialog box, find the file (or files) to import. 

• Select a “+” to open a list of folders and/or files. 

• Select the empty box to select the file or folder. 

Hint… To deselect a file, click the checkmark. When you deselect a folder, the 
files below the folder are not deselected. You must clear each file.

6. Select the Import button. The file is copied from the disk and is available in the 
Select a Patient screen.

Note… Do Not press the Eject button on the drive while the system reads from 
or writes to the disk.

If you try to eject or read the CD while the import process finishes, you 
can cause the drive to stop.

• To resend a stopped job: 1. Select the queue in the Devices list.

2. Select a job marked ‘Stopped’ from the Queued Jobs 
list, or Ctrl+click to select many jobs.

3. Verify that the selected job is the job to resend.

4. Select the Resend Stopped Job button.

5. Select the OK button.

Table 6-6: How to Use Manage Queues

Option Steps



70 Part Number MAN-01384 

Instructions for Use
Chapter 6 - The Select a Patient Screen
Menu Bar

8.2.8 Retrieve Priors

To find the Images in the Local Database, select the Local Exams tab and search for 
the Patient. 

To Retrieve Priors from the PACS system:

1. Select Admin > Retrieve Priors.

2. Enter the Patient name in the Name field or ID in the ID field (wildcards allowed).

3. To limit the results to a date range, select the checkbox Search by Date Range, 
then enter the Date Range for the Prior Images. The date format must match the 
configuration setting, (mm/dd/yyyy or dd/mm/yyyy).

4. Select the Query button or press the Enter key. If the button is not enabled, you 
need more characters in either the Name field or ID field.

5. Select the Patient name (or names) to import.

• You can select many Patients.

• You can deselect Patients.

• You can use the title bars to sort by field.

6. When the Import button activates, select Retrieve and Import. The images 
import into the Acquisition Workstation Local Database.

7. Select the OK button.

8. Select the Close button.

After the import completes, select the Local Exams tab to display the Patient Images. 
If there are more than 50 records in your query request results, adjust your search.

8.2.9 MPPS Status

When this optional feature is installed, a menu item is added to sites with the MPPS 
Service Class Provider. Workflow changes with three Close Procedure options 
instead of one option.

8.2.10 Calibrations

When Calibration is needed, the Select a Patient screen remains in Standby and the 
Calibration Needed Alarm message appears in the System Message box.

When you turn on the system, a message appears if the system needs any 
calibration. You cannot acquire the patient exposures until you perform the required 
calibration. All the review, resend, and administrative functions continue to work.

Note… Clean the detector and acrylic block before you perform a Calibration.

Caution: Make sure that you follow the directions on the screen when you 
calibrate a system.

If you are in the Calibration Mode screen by accident, select the End Calibration 
button. If you started the Calibration, but you did not accept images, you can reject 
the Image and exit the Calibration.

Note… When you accept one image, do Not end the calibration before you 
acquire, view, and accept all the images.



Part Number MAN-01384 71

Instructions for Use
Chapter 6 - The Select a Patient Screen

Menu Bar

8.2.11 Test Patterns

1. Select Admin>Test Patterns.

2. Select the Preview size (Figure 6-20, No. 1).

3. Select the Test Pattern from the Pattern field (No. 2). 

4. From the Output area of the screen (No. 3):

• Select the Output Device.

• Select the Film Size.

• Select the Print True Size checkbox, if needed.

Figure 6-20: Test Pattern Dialog Box

5. Select from the following options (No. 4):

• To view the test pattern Full Screen, select the Preview button. To return to 
the dialog box, click any area on the Full Screen.

• To send the Test Pattern to the selected output, select the Send button.

• To remove any files from previous “sends” before you send the current 
images, select the Clean Up button.

• To exit the Test Pattern option, select Close.

8.2.12 DR Device Control

This function is for use by service personnel.
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8.2.13 Available Disk Space

This option displays the remaining number of images the hard disk drive and CD 
can hold. 

The system automatically deletes some Images/Patients at specified levels to get 
back hard disk drive storage space for new Procedures. Automatic image removal 
does not include the following:

• The Images in a queue to an output device. 

• The images for Protected Patients. (Make sure you unprotect Patients when you 
do not need their files.)

• The Images that are not successfully committed to an archive device. (Archive 
devices send commitments after Images go to long-term storage.)

• Rejected Images. The Managers need to remove rejected Images.

Caution: The system will not acquire an image if the disk does not have enough 
available space. A message displays the capacity of the disk. Delete the 
images that are not needed to restore the disk space.

8.3 Info Menu
The Info menu displays the information about the Acquisition Workstation.

9.0 Special Modes Buttons

9.1 Non-imaging Mode Button
The Non-imaging mode is available to all users and allows the x-ray exposure without the 
acquisition of images. This mode is not available when you have a Patient selected. When 
you select the Non-imaging mode, the Image Receptor deactivates.

To access this mode, select the Non-Imaging Mode button. 

Figure 6-21: Non-Imaging Mode Button

Caution: Make sure that you protect the Image Receptor from excessive 
radiation by covering it with lead while using this mode.

To exit the Non-Imaging mode, select the End Non-Imaging Mode button.

9.2 The Review Button
This button is used during the Reject /Unreject process. See Chapter 8, Section 5.2, page 93.
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9.3 The Simulate Capture Button

This function is for use by service personnel.

10.0 Generator Status
This area displays the current status of the system. See Figure 6-1, page 47.

11.0 System Messages
The System Messages area displays the system status. The displays in the message area are 
important when you restart the system after an Emergency Stop Switch is used.

12.0 Alarms

Figure 6-22: The Alarm Icon

Alarms are generally output problems that occur due to jobs that fail at the output device. 
The Alarm Icon shows the number of alarms. Select the icon to view the details. Erase the 
alarm to clear it.
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Chapter 7 - The Patient Views Screen

When you select a Patient, the Views for the scheduled Procedure display on the Patient 
View screen in your preset order. The program automatically highlights the first View in the 
sequence. To choose a different View, select that View.

Figure 7-1: Patient View Screen

Table 7-1: Actions on the Patient Views screen

Topic Information

Work with Views (1) Section 1.0, page 76
Add/Edit the Patient Information Chapter 6, Section 3.0, page 49
Add/Edit a Procedure (2) Chapter 6, Section 5.0, page 51
Select the Image Output Chapter 6, Section 6.0, page 53
Jobs in the Queue (3) Displays the number of jobs in the outputs.
Change Exposure Techniques Chapter 6, Section 7.0, page 54
Acquire the View Section 2.0, page 77
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1.0 Work with Views

Figure 7-2: Buttons Used on the View Screen

Table 7-2: View Options

Option Actions

Add View (1) 1. Select the Add View button. 

2. Select an additional View from the list of Standard 
Mammography Views. To add many views, hold the Control 
key down and select the View.

3. Select the OK button.

4. Select the new view before you acquire the image.
Remove Unexposed (2) Unused views are automatically reclaimed, but you can delete 

the views with the Remove Unexposed Views button.

1. Select the All button (or the Selected button then indicate 
which views to delete).

2. Select the Remove Unexposed button.
Implant Present 
Checkbox (3)

Select the box if there is an implant present in the breast.  The 
box should remain checked for all views in the procedure.

Close Procedure (4) 1. Select the Close procedure button.

2. Select the Yes button to close the procedure or the No 
button stay on the screen.
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2.0 Acquire Images
The system is ready to acquire Images when the Generator Status indicates “Ready” 
(Figure 7-3, #1), and the X through the X-ray symbol (#2) in the Generator Status box is not 
displayed. 

Figure 7-3: Ready for Exposure Indicators
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Introduction

Chapter 8 - The Preview Image Screen

1.0 Introduction
The Preview Image screen appears when you acquire an image. The right side of the screen 
has image tools and buttons to accept or reject the image.

Figure 8-1: The Preview Image Screen

2.0 The Preview Image
The Preview Image is a non-diagnostic, processed image for anatomy and position 
confirmation. The Patient Name, ID, and the View appear on a bar on the top of the Preview. 

2.1 Progressive Preview
The first preview image appears for a quick check of the breast position. This image updates 
with an image of better quality to check for motion or image artifacts.

Legend for Figure 8-1

1. Acquired Image Display Area

2. Tools
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2.2 Film Label Area
The film label area which is the small rectangle in the upper, left corner is blank in the 
Preview. 

A Digital Marker next to the label displays the Technologist initials and the marker for the 
selected View. You can move or change the marker.

2.3 Hanging Options
The Images in this manual are displayed in the Dorsal orientation (the Operator faces the 
patient).

Figure 8-2: Hanging Options

This option can affect how images display on your diagnostic workstation. Confirm the effect 
of the options with the vendor.
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3.0 Tools for Image Enhancement and Annotation

1 Comments

Figure 8-3: The Preview Screen Tools

2 Markers
3 Edit View
4 Implant Present
5 Zoom/Pan Thumbnail
6 Crosshair
7 Measurement
8 Window/Level
9 ROI size Drop-down
10 Set Center/Width
11 Display AEC Regions
12 Exposure Index
13 Exposure Techniques
14 Reprocess View
15 Magnification
16 Full Zoom/Pan
17 Quick Zoom/Pan
18 ROI
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3.1 Comments
The comment text is inserted in the DICOM header of the Acquired Image. The diagnostic 
review workstation displays the comments.

Figure 8-4: Image Comments

1. Select the Comments button.

2. Select the Additional Comment checkbox.

3. Select the field below the checkbox and enter your comment.

4. Select the OK button to save the comment.

Note… To remove all comments, select the Clear Comments button. To close 
the dialog box without a change to the comments, select the Cancel 
button.
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3.2 The Edit View Button and Markers

3.2.1 How to Use the Marker function

1. If the marker is wrong, select the Clear All Markers button

2. Select the Tab for the set of markers you need.

3. Select the marker you need. You can select a maximum of three markers from 
the available set for each image.

4. Move the marker to the correct position.

If you change a Marker, you change the label on the image, but not the DICOM 
header. You will not see the change on the Patient View page.

3.2.2 How to Use the Edit View button

Before You Accept the Image

1. Select the Edit View button.

2. Select the required view from the displayed list.

3. Select OK. The correct image displays on the preview screen and the marker 
and the direction the image hangs are correct.

After You Accept the Image

If the image is Accepted before you notice the wrong view, the incorrect image was 
sent to the selected output. Make the corrections, then resend the corrected image 
with the Image or Spool Management menu. See Chapter 6, Section 8.2.1, page 65.

1. Before You Make Any Changes:

• If you printed the mislabeled image, find and discard that image.

• If the image was sent to a diagnostic review workstation, delete the 
mislabeled image.

• If the image was sent to the PACS, tell the PACS administrator to delete the 
mislabeled image.

2. Repreview the Image (Chapter 6, Section 8.2.3, page 67).

3. Select the Edit View button on the Preview screen.

4. Select the required view from the displayed list.

5. Select Save. A new thumbnail image appears. Resend this image.

Select the Edit View button to update the DICOM 
header and enable the image to hang correctly at the 
Diagnostic Review Workstation.
The tabs and buttons allow you to change just the 
Marker.

Figure 8-5: The Markers in the 
Preview Pane
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3.3 Implant Present
Select the checkbox on the Patient View screen when an implant exists. When the checkbox 
is selected, the system marks future images with an Implant Present label. The checkbox on 
this screen enables you to change the selection before you accept the image.

3.4 Quick Zoom/Pan
Quick Zoom/Pan is active after the image is first displayed, before image processing completes.

1. Select the Quick Zoom/Pan button. 

2. To pan through the image, drag with the right trackball button. 

3. To turn off the function, select the Quick Zoom/Pan button.

3.5 Full Zoom/Pan

Figure 8-6: Full Zoom/Pan Image

The Full Zoom/Pan function becomes available after image processing is complete. The box 
in the thumbnail image on right side of the screen shows where the magnification view is in 
the complete image. You can move this box to any area in the image. 

1. Select the Full Zoom/Pan button. 

2. To move through the image, drag with the right trackball button. 

3. To turn off the function, select the Full Zoom/Pan button again.
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3.6 ROI

Figure 8-7: ROI Size Drop-down Menu

Method 1: Draw a custom box. Method 2: Use a pre-defined box size.

1. Select the ROI button.

2. From the drop-down menu, select 
User Draw.

3. Click in the image and drag to 
draw the size you need.

1. Select the ROI button.

2. From the drop-down menu, select 
the size.

3. Click the area of interest in the 
image.
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3.7 Crosshairs

Figure 8-8: Preview with Crosshairs

1. Install a localization paddle.

2. Acquire the image.

3. If necessary, select the Zoom/Pan button and move through the image.

4. Select the Crosshair button.

5. Select the area of interest in the image. 

6. Drag the crosshairs to the needed position, or select another area.

7. If necessary, use the Zoom/Pan functions to follow the crosshair lines to the grid from the 
localization paddle. The crosshair lines remain when the Zoom/Pan function is enabled 
and disabled.
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3.8 Measurement

Figure 8-9: A Measurement on the Preview Screen

1. Select the Measurement button.

2. Click the first point then drag to the second point. The distance displays when you 
release the button. 

3. Select the “+” at either end of the line to clear. There lines are not saved with the image.
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3.9 Magnification
Use the Magnification function to view part of the image at 2X the displayed resolution.

1. Select the Magnification button.

2. Move the box that appears at the area of interest.

3. To turn off the magnification function, select the Magnification button a second time.

Note… You can use the magnification function on a Full Zoom image.

Figure 8-10: Preview with Magnification
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3.10 Window/Level
1. Select the Window/Level button.

2. Select in the image and hold while you move the trackball.

• Roll Up or Down to change the brightness (Level).

• Roll Right or Left to change the contrast (Window).

3. To return to the original settings, double click the image.

4. Select the Window/Level button to turn off the feature.

Note… This operation does not change the final, processed Image.

Figure 8-11: The Window/Level Settings

To enter a known Window/Level value:

1. Select the field (Center or Width) to change.

2. Enter a new number.

3. Select the Set button. 

To return to the original setting, double click the image.
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3.11 Display AEC Regions
To display the AEC area selected by the system, select the Display AEC Regions checkbox.

• Manual sensors show on the image as a white rectangle with rounded corners. 

• The two Auto Sensor areas show on the image as 1cm by 1cm white squares.

To hide the AEC areas, deselect the Display AEC Regions checkbox.

Figure 8-12: AEC Regions
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3.12 Exposure Index
Use the Exposure Index as a general guide to compare the selected Exposure Techniques to 
the quality of the acquired image.

• “Image Status: OK” indicates the image processing was applied.

• “Image Status: Raw” indicates that image processing was not applied.

•  A number after the image status indicates a problem with the image processing. Reject 
the image. Content Service Support.

• For Manual and TEC modes, the Exposure Index calculates an area approximately one 
centimeter from the breast wall on the centerline of the image.

• For all AEC modes, the Exposure Index calculates for the AEC areas used.

3.13 Exposure and Dose/Entrance Surface Exposure Information

Figure 8-14: Exposure Information

The exposure information is displayed in the Tools area. An estimate of the average glandular 
organ dose and the entrance surface exposure are displayed.

4.0 Accept or Reject
Select Accept or Reject to close the Preview screen. The sequence continues by highlighting 
the next view.

4.1 Accept
To accept the image, select the Accept button.

• The full resolution image with all related attributes is marked as accepted in the pool.

• The system transmits the image to the selected output devices.

Figure 8-13: Exposure Information

Legend for Figure 8-13
1. Exposure Index-pixel count

2. Low exposure area—evaluate the image 
for excess noise. Re-acquire, if 
necessary.

3. Acceptable, but below ideal exposure 
area

4. Ideal exposure area

5. High exposure area—the image is more 
than sufficient. You can reduce the 
radiographic technique for the next 
exposures.

6. The Exposure Index line related to 
imaging of the ACR phantom
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4.2 Reject
To reject the image:

1. Select the Reject button.

Note… Reject Analysis uses this information (required for Quality Control).

Figure 8-15: The Reject Reasons List

2. Select the reason for the reject.

3. Select the Reject button. The system moves the image to the Reject Bin. An asterisk 
displays next to the View label of a rejected image.

Figure 8-16: A Rejected Image
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5.0 Additional information about Accepted/Rejected Images
After you reject an image, the Preview closes and you can:

• Re-acquire the rejected View.

• Select a different View. 

• Close the Procedure.

5.1 The Image Repetition Information Dialog Box
When you accept a second image for the same View, the Image Repetition Information 
dialog box appears. 

1. Select the reason for the repeat.

2. Close the dialog box.

5.2 How to Accept a Rejected Image
To accept a rejected image:

1. Reject the image that was taken as the replacement for the rejected image.

2. In the Patient View screen, select the Review button (below the Output box).

3. In the Review dialog box, select the tab for the View.

4. Select the Rejected Image thumbnail image to accept. 

5. Select the Comments button to add or delete comments.

6. Select the OK button to close the Comments dialog box.

Figure 8-17: Set Accepted Button on Review Screen

7. Select the Set Accepted button.

8. Select the OK button to close the Review dialog box.

Figure 8-18: Accept Rejected Image
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When you accept a rejected image, the Send Image to Output dialog box displays. Select Yes 
to send the images to the selected output group.

Note… If you select the No button, you can resend the images with the Image/
Spool Management function.

5.3 How to Reject an Accepted Image
To reject the Accepted Image:

1. In the Patient View screen, select the Review button.

2. In the dialog box, select the tab for the View to reject.

3. Select the Accepted Image.

Figure 8-19: Set Rejected Button

4. Select the Set Rejected button. 

5. Select a reason for the reject. See Figure 8-15, page 92.

6. Select the Reject button.

7. Select the OK button. The displayed thumbnail image disappears from the Patient View 
screen.

Note… After you reject an Image with this method, the image is not removed 
from the output queues. To delete the image from the queues, see 
Table 6-6, page 68. The Rejected Image is added to the Reject Analysis 
Bin for tracking purposes. 
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Chapter 9 - Maintenance and Cleaning

1.0 General Information
Call the Hologic Technical Support telephone number for the current list of recommended 
cleaning solutions.

Before each examination, clean and use a disinfectant on any part of the system which 
touches a patient. Give the attention to the paddles and the Image Receptor Device.

Caution: Do not use any heat source (like a heating pad) on the image receptor.

Be careful with the plastic compression paddles. Inspect the paddles. Replace the paddle 
when you see damage.

1.1 For General Cleaning
Use a lint-free cloth or pad and apply a diluted dishwashing liquid.

Caution: The fluid must not drip or run.

If more than soap and water is required, Hologic recommends any one of the following: 

• 10% chlorine bleach and water with one part commercially available chlorine bleach 
(normally 5.25% chlorine and 94.75% water) and nine parts water

• Commercially available isopropyl alcohol solution (70% isopropyl alcohol by volume, 
not diluted)

• 3% maximum concentration of hydrogen peroxide solution

After any of the above solutions, use a pad and apply a diluted dishwashing liquid to clean 
any parts which touch the patient.

Caution: Do not spray disinfectant on the system, because the moisture can 
enter into the system and damage the electronic components.

Warning: If a paddle touches any possible infectious materials, call your 
Infection Control Representative for decontamination 
instructions.

1.2 To Prevent Possible Injury or Equipment Damage
Never use a corrosive solvent or abrasive detergents or polishes. Select a cleaning agent 
which will not damage plastics, aluminum, or carbon fiber. 

• Do not use a strong detergent, abrasive cleaner, high alcohol concentration, or methanol 
at any concentration. If skin preparation contains a high alcohol concentration, allow 
time to dry before compression.

• Do not expose equipment parts to any steam or high temperature sterilization. 
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• Never allow any liquids to enter the internal parts of the equipment. Do not apply 
cleaning sprays or liquids to the equipment. Always use a clean cloth and apply the 
spray or liquid. If liquid enters the system, disconnect the electrical supply and schedule 
inspection by service personnel before the system is returned to use. 

Caution: Wrong cleaning methods can damage the equipment, decrease 
imaging performance, or increase the risk of electric shock. 

• Always follow the instructions from the germicide manufacturer. The instructions 
include the methods of concentration, storage, application, contact time, wash 
requirements, protective clothing, shelf life, and for removal. The instructions describe 
the best and safest product use.

2.0 Care and Cleaning—Acquisition Workstation and Value Console

2.1 Display
Avoid touching the display screen. 

Care should always be used when cleaning the outer surface of the LCD screen. Always use 
a clean soft, lint-free cloth. Microfiber cloths, available at most camera stores, are highly 
recommended.

• Never spray or pour a liquid directly onto the screen.

• Never apply excessive pressure to the screen.

• Never use detergents with fluorides, ammonia, alcohol, or abrasives.

• Never use bleach.

• Never use steel wool, or cloth woven with metal.

• Never use a sponge with abrasives.

There are many commercially available products that are specifically designed for cleaning 
LCD displays. Any of the products free of the ingredients mentioned above and used in 
accordance with the manufacturer’s directions can be used.

2.2 Keyboard and Trackball or Mouse
Wipe clean the keyboard and trackball or mouse surfaces using a standard CRT wipe. If 
necessary, clean the keyboard with a vacuum. If liquids spill into the keyboard, call Service 
for a replacement.
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3.0 Preventive Maintenance

Table 9-1: User Preventive Maintenance

Recommended Frequency

Maintenance Task Description
Each 
Use

Daily Weekly Biweekly Monthly Quarterly
Semi-

annually

Clean & disinfect paddle x
Clean & disinfect breast platform x
Visually inspect all paddles for damage x
Recommended/ required start of operation 
verifications

x x

All daily recommended/ required calibration x x
Diagnostic Review Workstation Quality Control * x
Detector Flat Field Calibration * x
Artifact Evaluation * x
Phantom Image * x
Signal to Noise / Contrast to Noise Measurements * x
Geometry Calibration (Tomosynthesis Option) * x
Compression Thickness Indicator * x
DICOM Printer Quality Control x
View boxes and Viewing Conditions x x
Repeat/Reject Analysis* x
Compression * x
Visual Checklist * x
Emergency Stops x
Clean array dust filter x

* Refer to Quality Control Manual
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1.0 Dimensional Information

1.1 Tubestand (Gantry with C-arm)

1.2 Acquisition Workstation

Figure A-1: Tubestand Dimensions
Height 190.0 cm (74.8 in.)±1.0 cm (0.4 in.); 213.0 cm 

(84.0 in.) ±1.0 cm (0.4 in.) at highest C-arm travel
Width 65.0 cm (25.6 in.) ±1.0 cm (0.4 in.) (C-arm at 0° 

position)
Depth 110.0 cm (43.3 in.)±1.0 cm (0.4 in.)
Weight 274 kg (604 lb) ±20 kg (44.0 lb)

Figure A-2: Acquisition Workstation Dimensions
Overall Dimensions 189.2 cm (74.5 in.) (H) x 107 cm (42.1 in.) (W) x 

76 cm (30.0 in.) (D) (maximum) 
Weight 154 kg (340 lb) (maximum)
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1.3 Acquisition Workstation with Dual Swivel Arms

1.4 Selenia Value Console

Figure A-3: Acquisition Workstation with Dual Swivel Arms
Overall Dimensions 195.6 cm (77.0 in.) (H) x 107 cm (42.1 in.) (W) x 

76 cm (30.0 in.) (D) (maximum)
Weight 218 kg (480 lb)

Figure A-4: Value Console Dimensions
Overall Dimensions 189.4 cm (74.6 in.) (H) x 101.2 cm (39.8 in.) (W) 

x 60.5 cm (23.8 in.) (D) (maximum) 
Weight 163.3 kg (360 lb) (maximum)
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2.0 Operating Environment

2.1 General Operating Conditions

3.0 Storage Environment

3.1 Tubestand

3.2 Image Receptor

4.0 Electrical Input

4.1 Tubestand

4.2 Acquisition Workstation

Temperature Range 20 °C (68° F) to 30 °C (86° F)
Maximum rate of temperature change <10 ºC/hr 
Relative Humidity Range 10% to 80% non-condensing
BTU output Typical Range 1700–2500 BTU/hr

Temperature Range -25 °C (-13° F) to +60 °C (140° F) 
Humidity Zero to 95% humidity—non-condensing (not 

packaged for outdoor storage)

Storage Temperature Range 10 ºC (50° F) to 40 ºC (104° F)
Maximum rate of temperature change <15 ºC/hr
Storage Humidity Range 10% to 80% humidity— non-condensing (not 

packaged for outdoor storage)

Mains Voltage 200/208/220/230/240 VAC nominal, true sinusoidal, 
(tap selectable at installation) ±10%, Single Phase, 
50/60 Hz ± 5%, permanently wired

Mains Impedance Maximum line impedance not to exceed 0.20 ohms 
for 220/230/240 VAC, 0.16 ohms for 200/208 VAC

Maximum Power Consumption 6.5 kVA for 5 second duration
Standby Current 2.0 A (maximum)
Maximum Line Current 35 A for 5 seconds (momentary rating per NEC 

660.2)
Recommended Branch Circuit 
Breaker Rating

25 A minimum, refer to NEC 660.6

Input Line Voltage 100/120/200/208/220/230/240 VAC nominal, true 
sinusoidal, (tap selectable at installation), ± 10%

Input Current 8.0 A maximum @ 100/120 VAC
3.5 A maximum @ 200/208/220/230/240 VAC

Frequency 50/60 Hz ±5%
Number of Phases Single
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5.0 Acquisition Workstation Technical Information

Operating System Sun™ Solaris OS
Computer Memory 2 GB RAM minimum
Disk capacity > 60 GB Image Storage
Storage Media CD-RW Disks
Display Adapter Card 1600 x 1200 matrix minimum 8 bit gray scale display
Display 1600 x 1200 matrix minimum 450 cd/m2 nominal 

brightness
Network Interface 10/100 Base-T Ethernet
Remote Diagnostics Internet
Graphical User Interface X-ray exposure control

Configurable mammographic Workflow
Patient demographics
Brightness and contrast control
Magnification screen
Pixel value readout
QC test tools 
System Status Monitoring
Error reporting
Unattended archiving and printing

Radiation Shield Pb equivalence Rated for a 0.5 mm Pb (lead) equivalence
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6.0 Tubestand Technical Information

6.1 C-arm

6.2 Compression

Motorized C-arm Rotation Speed Variable speed (18° per second maximum). Rotation 
speed is service selectable: 50% to 100% in 5% 
increments. Motor Control provides soft start and 
dynamic braking.

C-arm Rotation Range +195° +2° /-0° to 0° ±0.5° to -150° +0° /-2° (detent 
at 0°, ±90°). Rotation angle is displayed on both sides 
of Gantry.

Vertical Travel 74.5 cm (29.5 in.) total travel.
Source-to-Image Distance (SID) 66.0 cm (26.0 in.) ± 1.0 cm (0.4 in.) 
Source-to-Image Receptor Support 
Device Distance

64.0 cm (25.2 in.) ± 1.0 cm (0.4 in.)

Magnification Ratio 1.8 x for objects 22.5 mm above the magnification 
platform breast support surface

Manual Compression Force Limited to a maximum of 300 N +0/-89 N (67.4 lb 
+0/-20 lb) from 0° to +/-90° C-arm rotation. Not less 
than 169 N (38 lb) for a C-arm angle range greater 
than +150° and an angle less than -150°.

Motorized Compression Functions in three operating modes, Pre-
compression, Full-Range, Dual Compression, user 
selectable through software.

          Pre-Compression Force 67 N +0/-22.3 N to 133.5 N ±22.3 N (15 lb +0/-5 lb 
to 30 lb ±5 lb)

          Full-Range Compression Force 89 N ±22.3 N to 178 N ±22.3 N (20 lb ± 5.0 lb to 
40.0 lb ± 5.0 lb)

          Dual Mode Compression Provides Pre-Compression force upon first activation 
of compression switch; then, if switch is activated 
within 2 seconds, the force is increased 
incrementally for each additional switch activation, 
up to the user selected FULL compression force.

Compression Controls Up/Down controls on both sides of C-arm and on 2-
position footswitch (Motorized). Handwheel on both 
sides of Compression Device (Manual).

Compression Release Manual or Automatic. Motorized Release mode 
controlled by push-buttons on both sides of the C-
arm. User selectable automatic release mode raises 
Compression Device upon exposure termination. All 
release functions are disabled if a Localization 
paddle is detected.

Automatic Compression Release Moves the compression device upward a 
predetermined distance (10 cm). For Magnification 
Mode this may be less.
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6.3 X-ray Tube: Molybdenum

6.3.1 X-ray Tube Housing

Compression Down Motion 
Variable Speed

Service Selectable between approximately 10% 
through 100% of full speed.

Compression Force Display Two LED Displays on the Compression Device show 
the compression force through the range of 10 lb to 
67.4 lb (44.5 N to 300 N) in 1 lb (4.4 N) increments.

Compression Force Display 
Accuracy

±4.5 lb (±20 N)

Compression Thickness Display Two LED Displays on Compression Device measures 
between 0 and 15 cm above image receptor in 0.1 
cm increments. The display is visible from both sides 
of the patient.

Compression Thickness Accuracy ±0.5 cm for thicknesses between 0.5 cm and 15 cm
Compression Paddles Compression paddles are transparent. The paddles 

are composed of polycarbonate. The paddles provide 
a parallel plane to the image receptor and do not 
deflect by more than 1 cm difference from any 
surface providing compression under 25 lb (111.1 N) 
of compression force (except for F.A.S.T. paddles.). 
The paddles are adjustable to provide the focal spot, 
compression device and image receptor alignment 
requirement.

Focal Spot (NEMA / IEC) Large (0.3 mm) Nominal
Small (0.1 mm) Nominal

Tube Voltage 20 kV to 39 kV
Tube Current Large Focal Spot = 100 mA between 25 and 32 kV 

Small Focal Spot = 30 mA between 25 and 32 kV 
Anode Rotation 180 Hz (9600 RPM minimum)
Anode Angle Bi-angular: Large focal spot at 16°, Small focal spot 

at 10°. X-ray tube angle at 6° to provide 22° (Large 
FS) and 16° (Small FS) anode to Image Receptor 
plane angle.

Anode Material Molybdenum
X-ray Window Beryllium 0.8 mm thickness (maximum)

Over Temperature Protection Sensor Internally connected in series with the stator 
common lead.

Maximum Temperature, Tube 
Housing Surface 

55 °C (151° F)

Maximum Temperature, Tube Head 
Cover Surface

41 °C (105.8° F)

Safety Class IEC 60601-1, Class I,IEC 60601-2-28
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6.3.2 X-ray Beam Filtration and Output

Inherent Tube Filtration 0.0 mm Al equivalent
Added Filtration Two-position filter changer mechanism to carry a 

30-micron (0.03 mm) Molybdenum foil filter and a 
30-micron (0.03 mm) Rhodium foil Filter. Type of 
filter is user selectable.

Beam Quality HVL for Mo/Mo 
Operation

At a given kilovolts, the measured HVL with the 
compression paddle in the x-ray beam is equal to or 
greater than the value of kV/100+0.03 (in units of 
mm of aluminum) but less than the value of kV/
100+0.12 (in units of mm of aluminum).

Beam Quality HVL for Mo/Rh 
operation

At a given kilovolts, the measured HVL with the 
compression paddle in the x-ray beam is equal to or 
greater than the value of kV/100+0.03 mm Al (in 
units of mm of aluminum) but less than the value of 
kV/100+0.19 mm Al (in units of mm of aluminum).

Radiation Output Equal to or greater than 800 mR/second for at least 3 
seconds. Output is measured through the 
Compression Paddle, 4.5 cm above the breast 
support, 4.0 cm from the chest wall edge, using 
exposure techniques of Mo/Mo target/filter, large 
focal spot, 28 kV.
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6.4 X-ray Tube: Tungsten

6.4.1 X-ray Tube Housing

6.4.2 X-ray Beam Filtration and Output

Focal Spot (NEMA / IEC) Large (0.3 mm) Nominal
Small (0.1 mm) Nominal

Tube Voltage 22 kV to 39 kV
Tube Current Large Focal Spot = 100 mA between 25 and 32 kV 

Small Focal Spot = 30 mA between 25 and 32 kV
Anode Rotation 180 Hz (9500 RPM minimum)
Anode Angle Bi-angular: Large focal spot at 16°, Small focal spot 

at 10°. 
X-ray tube angle at 6° to provide 22° (Large FS) and 
16° (Small FS) anode to Image Receptor plane angle.

Anode Material Tungsten
X-ray Window Beryllium 0.8 mm thickness (maximum)

Over Temperature Protection Sensor Internally connected in series with the stator 
common lead.

Maximum Temperature, Tube 
Housing Surface

55 °C (151° F)

Maximum Temperature, Tube Head 
Cover Surface

41 °C (105.8° F)

Safety Class IEC 60601-1, Class I, Type B, IEC 60601-2-28

Inherent Tube Filtration 0.0 mm Al equivalent
Added Filtration Two-position filter changer mechanism to carry a 60-

micron (0.06 mm) Rhodium foil filter and a 60-
micron (0.06 mm) Silver foil Filter. Type of filter is 
user selectable.

Beam Quality HVL for W/Rh 
Operation

At a given kilovolts, the measured HVL with the 
compression paddle in the x-ray beam is less than the 
value of kV/100 +0.03 (in units of mm of aluminum).

Beam Quality HVL for W/Ag 
operation

At a given kilovolts, the measured HVL with the 
compression paddle in the x-ray beam is less than the 
value of kV/100 +0.03 (in units of mm of aluminum).

Radiation Output Equal to or greater than 230 mR/second for at least 3 
seconds. Output is measured through the 
Compression Paddle, 4.5 cm above the breast 
support, 4.0 cm from the chest wall edge, using 
exposure techniques of W/Rh target/filter, large focal 
spot, 28 kV.
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6.5 X-ray Collimation
Available Collimated X-ray Fields:

6.6 Light Field Indication

6.7 X-ray Generator

Table A-1: Collimation 
Settings

Predefined Collimation 
Settings

24 x 29 cm
18 x 24 cm
15 x 15 cm
10 x 10 cm

7.0 x 8.5 cm

Light Field Lamp Illuminates for 30 seconds, ±5 seconds, upon 
pressing a Light Field switch on either side of the x-
ray tubehead or by pressing a Compression Down 
switch. Extinguishes automatically upon exposure 
initiation. A shatter shield is provided.

Light Field Illuminance 160 lux (minimum)—meets 21 CFR 1020.31 
requirements. Lamp is adjustable to provide 
alignment of the light field to the x-ray field.

Light Field-to-X-ray Field 
Congruency

Within 2% of SID

Output Rating 3.2 kilowatt, maximum (isowatt), 100 mA @ 32 kV
Ripple 2% or less (typical), maximum 4%
Topology Pulse width modulated High Frequency, active servo 

controlled
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6.7.1 kV /mA Range

Note… All above values are for mAs values ≥40 mAs. For mAs values < 40 mAs, the 
mA value is adjusted by the mA Factor listed in the table below as a 
function of mAs.

Table A-2: mA setting as a function of kV

Large Focal Spot

kV mA

20* 75 mA
21* 80 mA
22 85 mA
23 90 mA
24 95 mA
25-32 100 mA
33 85 mA
34-35 80 mA
36-37 75 mA
38-39 70 mA
*Molybdenum Tubes only

Table A-3: mA setting as a function of kV

Small Focal Spot

kV mA

20 20 mA
21 22 mA
22 24 mA
23 26 mA
24 28 mA
25-32 30 mA
33-34 28 mA
35-37 26 mA
38-39 24 mA

Table A-4: mA Factor as a function of mAs

mAs mA Factor

4-6 10%
8-10 20%
12-22 30%
24-38 60%
≥40 100%
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Large Focal Spot Manual mAs Range: 

Note… Lower limit is 4 mAs when grid is in field.

Note… Lower limit is 4 mAs when grid is in field.

Note… In AEC modes, in Large Focal spot, the mA setting adjusts downward, if 
necessary, to achieve the calculated mAs. mA can be adjusted as low as 
10 mA.

Small Focal Spot Mag Manual mAs Range: 

6.7.2 Accuracy, Reproducibility, and Linearity

TABLE 1 (default): 3 mAs through 400 mAs, 22 steps: 3, 4, 5, 6.4, 8, 10, 
12.5, 16, 20, 25, 32, 40, 50, 64, 80, 100, 125, 160, 
200, 250, 320, 400.

TABLE 2 (user selected): 3 mAs through 400 mAs, 55 steps: 3, 4, 5, 6, 7, 8, 9, 
10, 12, 14, 16, 18, 20, 22, 24, 26, 28, 30, 32.5, 35, 
37.5, 40, 42.5, 45, 47.5, 50, 55, 60, 65, 70, 75, 80, 
85, 90, 95, 100, 110, 120, 130, 140, 150, 160, 170, 
180, 190, 200, 220, 240, 260, 280, 300, 325, 350, 
375, 400.

TABLE 1: 3 mAs through 100 mAs, 16 steps: 3, 4, 5, 6.4, 8, 10, 
12.5, 16, 20, 25, 32, 40, 50, 64, 80, 100

TABLE 2: 3 mAs through 120 mAs, 38 steps: 3, 4, 5, 6, 7, 8, 9, 
10, 12, 14, 16, 18, 20, 22, 24, 26, 28, 30, 32.5, 35, 
37.5, 40, 42.5, 45, 47.5, 50, 55, 60, 65, 70, 75, 80, 
85, 90, 95, 100, 110, 120

Reproducibility < 0.05 coefficient of variation for 10 consecutive 
exposures (21 CFR). 

Linearity < 0.10 for adjacent mAs selections per the following:
(X1-X2) is less than or equal to 0.10 (X1+X2) where 
X1 and X2 are average mR/mAs values for 
consecutive exposures (21 CFR).

mAs Accuracy ±5% or ±2 mAs, whichever is greater, from 
indicated, measured from the ground side of the tube 
circuit.

kV Accuracy Within 1 kV of the indicated kV
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7.0 Imaging System Technical Information

7.1 Image Receptor

Fluid ingress No fluid from incidental spillage on the top surface 
of the Image Receptor seeps inside

Deflection Does not exceed 1.0 mm at maximum compression
Active Imaging Area 24 cm x 29 cm Nominal. The active image area is 

marked on the digital image receptor/breast platform 
cover.

Image Size, Screening and 
Diagnostic Exams

18 x 24 cm nominal; locations: center, left, right 
24 x 29 cm nominal; center location only

Image Size, Diagnostic-Spot 
Compression

18 x 24 cm nominal; locations: center, left, right

Image Size, Diagnostic-
Magnification

18 x 24 cm nominal; center location only

Image Pixel Size 70 µm
Digital Image Receptor MTF -
Nyquist frequency

> 0.40

DQE at 0 c/mm 50% or greater at 7.0 mR -0.0/+0.7 mR x-ray 
exposure

DQE at Nyquist frequency 15% or greater at 7 mR -0.0/+0.7 mR x-ray exposure
Saturation X-ray exposure level at which image pixels are 

saturated is not less than 1000 mR
Dynamic Range Linear response over at least 400:1 in x-ray exposure 
Output Image 14 bit image data
Scatter Rejection Lorad HTC™ high transmission cellular grid
Chest Wall Access The distance from the outside edge of the Image 

Receptor enclosure to the Active Image Area along 
the chest wall is less than 5 mm.

Lateral Wall Access The distance from the outside edge of the detector 
enclosure to the active detector area along the edges 
perpendicular to the chest wall is less than 40 mm.

ACR Phantom Score at MGD = 
2mGy

At least 5 fibers, 4 specks, 4 mass

Image Preview Time The time between completion of an x-ray exposure 
and availability of the Preview image: less than 20 
seconds.

Transmission Limit Within Federal Regulatory limit for screen-film 
mammography systems (21CFR 1020): 0.1 mR/h.



Part Number MAN-01384 111

User Manual
Appendix A—System Specifications

Tissue Exposure Control (TEC) Mode—Enhanced Manual Mode

8.0 Tissue Exposure Control (TEC) Mode—Enhanced Manual Mode

9.0 Automatic Exposure Control (AEC)

The Breast Density Default Setting Selectable via the Generator default screen on the 
Acquisition Workstation. Breast density defaults to 
the default setting at the beginning of each new study 
and when the exposure mode is first changed to TEC.

Breast Density Panel Update rate once every 2 seconds maximum
Mammography Unit Status Polling Between image capture cycles, Acquisition 

Workstation requests and displays current technique 
at a rate not slower than once every 2 seconds. In 
TEC mode, the rate increases to no slower than once 
per second, but not faster than once per 0.75 
seconds. System response time for a single Generator 
Technique command is 1 second or less.

AEC Sensor Positionable in seven locations, centered laterally in 
the image receptor support device. Position #1 is 
located 1 cm from the chest wall. Positions are 
spaced in 1.7 cm increments.
The AEC region can be selected automatically by 
processing the pre-exposure image data to find the 
corresponding dense portion of the breast.
When the AEC region auto-selection is enabled, the 
detector area that is scanned is dependent on the 
default X-ray collimation that is linked to the 
compression paddle ID. Change of collimation by the 
operator is ignored for AEC region auto-selection.
LEDs for each AEC sensor position on the 
compression gantry indicate the selected position. 
The selected AEC region can be viewed after 
selecting the check box. 
The size and available position of the manual AEC 
regions are indicated at the x-ray input surface of the 
compression paddle.

AEC Auto-Filter Mode The filter and kV are selected using the 
recommended table based exposure technique based 
on compressed breast thickness. 
The exposure is terminated at an mAs value as 
determined by the AEC system to yield a pixel count 
to which the unit has been calibrated.

AEC Auto-kV Mode The Filter is not selectable. The filter defaults to Mo if 
the system is configured with Moly Tube. The filter 
defaults to Rh if the system is configured with a 
Tungsten Tube. Starting kV is determined by the 
Gantry. mAs is determined by the Digital Detector.
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AEC Auto-Time Mode The kV and filter are both user selectable.
The exposure is terminated at a mAs value as 
determined by the AEC system to yield a pixel count 
to which the unit has been calibrated.

Exposure Termination An exposure is aborted or prevented if:
The predicted exposure time exceeds the x-ray tube 
limits.The predicted exposure time exceeds the safety 
backup timer setting.
The predicted exposure time is less than 400 msec 
when the grid is in the x-ray field or less than 30 
msec when the grid is out of the x-ray field.
The user releases the exposure button prematurely.
There is an error within the Selenia FFDM system.

AEC Reproducibility AEC exposure reproducibility meets MQSA 
requirements as follows:
For a 4 cm thick average breast phantom, coefficients 
of variation in mAs and digital values shall be less 
than 0.05 for four consecutive exposures of this 
phantom under each of the three AEC modes.

Exposure Adjustment There is a “user-adjustable” scale factor that can be 
used to increase/decrease the final x-ray exposure 
(mAs) by 15% for each step from the default setting. 
A total of eight settings are available on the 
Acquisition Workstation, which allows the user to 
change the exposure from -55% of the default value 
to 160% of the default value.



Part Number MAN-01384 113

User Manual
Appendix A—System Specifications

Hardcopy Film Printing Devices

10.0 Hardcopy Film Printing Devices
This section lists the relevant technical characteristics for the hardcopy film printing device.

10.1 Image Engine

10.2 Interface

10.3 Printed Film

11.0 TechMate

Film sizes 20 cm x 25 cm (8 in. x 10 in.)
25 cm x 30 cm (10 in. x 12 in.), optional

Pixel size ≤70 µm
Grey level resolution ≥ 8 bits
Maximum Film Optical Density ≥ 3.5

Connectivity DICOM 3.0 compatible
Data port Ethernet
Transfer rate Minimum: 10 Mbits/sec
Look up Tables (LUT) Field programmable; Linear

Print to fit If a 24 x 29 cm image is printed on a 20 x 25 cm (8 x 
10 in.) film, the printer prints the image to fit onto a 
20 x 25 cm (8 x 10 in.) film without cropping the 
image or without dropping rows and columns of data

Patient Information Film meets ACR/MQSA requirements for patient 
demographics. Printed Information Is User 
Configurable.

CPU Dual Intel® Xeon® Processors
Operating System Microsoft Windows®
Computer Memory 2 GB RAM minimum
Disk capacity 400 GB SATA minimum
Display 3 Mega Pixel, 21 in. LCD, 2048 x 1536 resolution
User Interface Keyboard, Trackball
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General Information

Appendix B—The Mobile Selenia

This appendix provides information about Selenia systems installed in a mobile 
environment.

1.0 General Information

1.1 The Vertical Position Override Switch (VPOS)
The Mobile Selenia has a Vertical Position Override Switch (VPOS) on the back of the Gantry 
(see Figure B-1.) This switch can start the Selenia if the C-arm is lower than its normal 
operating position after rough-road travel.

Figure B-1: Location of Vertical Position Override Switch (VPOS)

1.1.1 When to use the VPOS

This condition shows on the first startup after transport. The Acquisition Workstation 
starts normally, but the Gantry does not startup. After Logon, an alert message 
appears that communication to the Generator is lost.

1.1.2 How to Use the Vertical Position Override Switch to Restart the Gantry

1. Press and hold the Vertical Position Override Switch—the Gantry starts. 
Continue to hold the switch pressed.

2. After approximately 5 seconds, lift the C-arm approximately 7.5 cm (3 inches) 
with the normal system controls. Release the VPOS after you lift the C-arm.

3. At the Acquisition Workstation, accept the prompt to restart the Generator. The 
Gantry turns off for a few seconds, then automatically restarts.

4. The system is ready for normal use.



116 Part Number MAN-01384 

Instructions for Use
Appendix B—The Mobile Selenia
Safety Conditions and Other Precautions

2.0 Safety Conditions and Other Precautions

Warning: The Selenia radiation shield is not approved for mobile use and 
is not provided. The coach manufacturer must provide radiation 
shielding that meets requirements.

Caution: When shore power is not available, use mobile power sources that 
provide the equivalent performance (see “Appendix A”). When 
continuous true sinusoidal VAC power is supplied per the 
specifications for Selenia power input and loading, system function 
and performance is correct. The power source must provide a 
minimum of 35A at 208VAC for a minimum of 5 seconds and support 
this load one time every 30 seconds. 
Separate, dedicated circuits must supply power to the Acquisition 
Workstation and Gantry. Use an uninterruptible power supply with 
active line conditioner for each power circuit. Other circuits must 
supply all secondary mobile coach power. 
After the first installation and when the mobile coach is moved, verify 
that the electrical installation meets the specifications of system 
power input and IEC 60601-1 safety requirements. 

Caution: Control the temperature and humidity inside the vehicle at all times. 
When the unit is not in use, do not allow environmental parameters to 
be more than specified specifications. 

Caution: When in use, connect the Selenia to a PACS system or an acceptable 
hard copy printer for permanent archive.
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3.0 Mobile Specifications

3.1 Shock and Vibration Limits

3.2 Coach Environment

3.2.1 Operating Environment

3.2.2 Non-operating/Transit Environment

3.3 Electrical Input

3.3.1 Tubestand

3.3.2 Acquisition Workstation

Vibration Limit Not greater than 0.35 G (2 Hz to 200 Hz), as 
measured at mounting point of system to coach.

Shock Limit Not greater than 1.0 G (½ sine pulse), as measured at 
mounting point of system to coach. An “air ride” 
coach suspension is recommended.

Temperature Range 20 °C (68° F) to 30 °C (86° F)
Maximum Rate of Temperature Change <10 ºC/hr
Relative Humidity Range 10% to 80% non-condensing
BTU output Typical Range 1700–2500 BTU/hr

Temperature Range 15 oC (59o F) through 35 oC (95o F)
Maximum Rate of Temperature Change <15 ºC/hr
Relative Humidity Range 10% to 80% non-condensing

Mains Voltage 200/208/220/230/240 VAC nominal, true sinusoidal, 
(tap selectable at installation) ±10%, Single Phase, 
50/60 Hz ± 5%, permanently wired

Mains Impedance Maximum line impedance not to exceed 0.20 ohms 
for 220/230/240 VAC, 0.16 ohms for 200/208 VAC

Maximum Power Consumption 6.5 kVA for 5 second duration
Standby Current 2.0 A (maximum)
Maximum Line Current 35 A for 5 seconds (momentary rating per 

NEC 660.2)
Recommended Branch Circuit 
Breaker Rating

25 A minimum, refer to NEC 660.6

Input Line Voltage 100/120/200/208/220/230/240 VAC nominal, true 
sinusoidal, (tap selectable at installation), ± 10%

Input Current 8.0 A maximum @ 100/120 VAC
3.5 A maximum @ 200/208/220/230/240 VAC

Frequency 50/60 Hz ±5%
Number of Phases Single
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4.0 How to Prepare the System for Transport
Perform these steps before you transport the Mobile System:

1. Rotate the C-arm to 0 degrees (CC position).

2. Lower the C-arm to its lowest position.

3. Remove all power from the system.

4. Remove all system accessories (like the Face Shield, and Compression Paddles) before 
transport. Store all accessories correctly to make sure the components are not damaged.

5.0 How to Test the System Integrity After Transport
Instructions: Photocopy this checklist for use after the system is relocated.

Name_____________________________________   Date_______________ 

System Serial Number____________________________________

Table B-1: Integrity Checklist

Evaluated Control Functions Reference

Mechanical System Tests
Compression Up/Down Chapter 3, "Compression Down," page 26
Compression Release Chapter 3, "Compression Release," page 26
C-arm Rotation Chapter 3, "C-arm and Gantry Rotation 

Switches," page 25
C-arm Up/down Chapter 3, "C-arm Up," page 27
Collimator Override Chapter 3, "Collimator Override," page 28
Light Field Lamp Chapter 3, "Light Field Lamp," page 27
Smart Paddle System Chapter 3, "Smart Paddle," page 28
Emergency Off Switches Chapter 2, "Emergency Off Switches," page 13

Quality Control Tests
Artifact Evaluation Selenia QC Manual
SNR/CNR Measurement Selenia QC Manual
Phantom Image Evaluation Selenia QC Manual
Compression Thickness Selenia QC Manual
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Index

A
accept

image 91
rejected image 93

Accept button 44–46, 91
accessories 1, 4

available 33
compression paddles 35–39

Smart Paddles 28, 36
magnification platform 40

acquire images 46, 77
Acquisition Workstation

circuit breaker location and function 12
description 11

add
additional view to procedure 45, 76
new entry with function key 16
new patient 49
new procedure with new accession number 51
user 62

AEC
alarm messages 58
Exposure Adjustment settings 57
modes 57
region, display on preview screen 90
select Exposure Mode with keyboard 16
sensor position 16, 20–21, 28
sensor position settings 58
using 57

alarms 73
AEC messages 58

annotation tools list 81
archive, commit to storage function enabled 65
asterisk, rejected image 92
AUTO AEC sensor

display region used 90
use 58

average glandular organ dose display 91

B
bar code scanner 3, 14, 16
Barco display 17
breast density 16

selecting in TEC 56

button
compression release 15
Eject, on CD-RW drive 69
on and x-ray 15

button (software)
Accept 49, 52, 91
Add View 45, 76
Brightness/Contrast (Window/Level) 89
Cancel/Clear 49, 52
Clean Up 71
Clear All Markers 83
Comments 82
Crosshairs 86
Edit View 83
Full Zoom/Pan 84
Implant Present 84
Import Priors 70
Magnification button 88
Markers 83
Measurement 87
New Patient 49
New Procedure 51
Query Retrieve Priors 70
Quick Zoom/Pan 84
Reject 93
Remove Unexposed Views 76
Resend 66
Resend Stopped Job 69
Retrieve and Import 70
Review 93
ROI (Region of Interest) 85
Set Accepted 93
Set Rejected 94
Simulate Capture 73
Window/Level (Brightness/Contrast) 89

C
calibration messages 70
care and cleaning 96
C-arm

components 11
controls and displays 19–20
Gantry rotation switches 19
rotation switches 20, 25
up and down 27
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CD, CD-RW
available space on 72
ejecting disks 69
importing images from 69

CD-RW Drive
Eject button 69
location 14

change Patient Information on Accepted Image 50
circuit breaker 4

Acquisition Workstation and Value Console 14
Gantry 12, 19

Clean Up button 71
cleaning, recommended 95
Clear All Markers button 83
Close

Exam (Procedure) key 16
Patient button 52
Procedure 46, 76

collimator
automatically set to paddle size 60
override 28

Comments
button 93
entering or modifying 82

commit function, archive 65
complaints, product xvi
compliance 6–7

label locations 8–9
compression

automatic release 103
controls and displays 21
down/up 26
force display accuracy 104
functional tests 26
release buttons 15
thickness

display 21
display accuracy 104

compression paddles 35–39
care 95
cleaning 35
FAST paddles 36
installing and removing 35

contrast, change for printer 67
controls 12–21

AEC sensor position 21
automatic compression release 26, 103
C-arm 20–21, 25, 27
C-arm rotation 20, 25
collimator override 20, 28
compression 20–21, 26
compression release buttons 15
handwheels 21
light field lamp 20, 27
location and appearance 25
manual compression 20

Crosshair device
aligning to localization paddle 42
installing and removing 41

Crosshairs 86

D
defaults

exposure modes 54
system 60
system view order 61

definitions xvii
delete job from queue 68
delete user 62
determine job status 68
digital markers 80
dimensions 99
disk

ejecting CD from drive 69
space available 72

Dismiss button 24
display 14, 17

AEC region used 90
Barco description 17
care and cleaning 96
Totoku description 17

Dorsal/Ventral hanging 80
dose/entrance surface exposure information 91
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E

E
edit

patient data 50
on an accepted image 50

patient data from MWL and PACS 50
procedure accession number 52

edit user 62
Edit View button 83
Eject CD 69
electrical input 101
Emergency Off switches 14, 19

location and function 13
restart dialog box 29

enhancement tools list 81
enter new patient data 49
entrance surface exposure display 91
environment 101
equipment damage, prevention 95
exam room door indicators 5
exposure

changing mode resets exposure techniques 55
duration 5
information 91
ready indicators 77

exposure index 91
exposure modes

AEC modes 57
function and use 55
manual 55
TEC 56

exposure pane, location 54
exposure techniques

AEC adjustments 57
reset to system defaults 54
select the mode 16
select with function keys 16
used 66

F
face shield 34
FAST paddles 36
files, select and unselect for import 69
film label area, location 80
film printer 11
filter, select with function key 16
flat screen display 17
focal spot, select 16
footswitches 3, 19, 21

function 11
Full Zoom/Pan 84
function keys 15–16

functional tests 25–28

G
Gantry

circuit breaker location and function 12
components 11
controls and displays 19
description 11
Emergency Off switches 19
restart mobile with VPOS 115
rotation switches for C-arm 19

Generator Status 77
grid in/out position toggle key 16

H
hanging options 80
Hologic technical support 95

I
image display area 79
image enhancement and annotation tools 81
Image Management

Repreview 67
Resend 66
using 65–67

image processing display 91
image receptor

aligning localization paddle with 42
no heat on 3
rotation switch 20
storage temperature 101
technical information 110

Image Repetition 93
image status 91
images

comments 82
film labeling area 80
identifying 49
import files from CD 69
outputs 53
Preview screen 79
processed 91
rejected 93
remaining space for 72
repreviewing 67
resending 66
Review dialog box thumbnails 93
rules for automatic reclamation 72
sizes 110
tools 81
viewing full resolution 88
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J

Implant Present 76
button 84

import
image files 69
priors in background 70

indicator, exam door 5
infectious materials on equipment 95
Info menu 72
initials, where used 62
initiating x-ray exposure 15
integrity checklist, mobile 118
intended uses xv
interlocks 6
international symbols xix

J
job status, determine 68
jobs in queue 53, 75

K
keyboard 15

care and cleaning 96
function keys, set exposure techniques 16

keypads 15
kV, select 16
kV/mA range 108

L
label locations 8–9
laser film printer 11
laser printer 2
Launch dialog box 24
light field lamp 27
local database 48
Local Exams, search 48
localization paddle 39

aligning crosshair device with 42

M
Magnification

crosshair device 42
paddles 39
platform 40

Magnification button 88
maintenance, general 95
Manage Queues 68

delete (cancel) job status 68
determine job status 68

manual collimation, effects 60
Manual exposure mode 55
Markers 83

digital 80
mAs

focal spots manual range 109
select 16

Measurement button 87
Menu bar 59
mobile information 115–118
mobile system

C-arm position switch 115
integrity checklist 118
safety considerations 116
specifications 117
temperature/humidity control requirements 116
tests, pre/post transport 118
Vertical Position Override Switch (VPOS) 115

modality worklist provider, query 48
monitor see display
monthly system tests 29
mouse 15

care and cleaning 96

N
New

Patient 49
Procedure 51

New Entry function key 16
Non-Imaging Mode, use 72

O
on and x-ray buttons 15
operating conditions 101, 117
Operating System (OS) 24
organization, Instructions for Use xx
outputs

accepted images sent to 91
add new output group 63
change/select destinations 53
edit output group 64
send accepted rejected images to 94

P
paddles

identification 38
realigning front edge with image receptor 37

Panel Power dialog box 29
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Q

Patient
add new 49
edit data 50
Face Shield 5
protecting from reclamation 67
unprotect 67

Patient Name, tab for local database 48
Patient View screen 43
pixel count 91
positioning, optimized for small breast with Smart
Paddle 36
post start-up tests 25
power button, TechMate 18
power failure 1, 30
Power On

button 15, 23
indicator light 15

PPS status 70
menu item 59

preventive maintenance 1, 97
Preview Image 43

screen 79
tools 79

printer 67
copies of images 66
print data on film 11
test patterns 71

procedure
add another

with different accession number 51
with same accession number 52

close with function key 16
Progressive Preview 79
Protect Patients 67, 72

Q
Quality Control

controls and functions tests 25
Reject Analysis 92

query
Local Exams 48
Modality Worklist 44, 48
retrieve priors 70
retrieve priors, results 70

Query button 44
queues

managing 68
Quick Zoom/Pan 84

R
radiation symbol, X-ray indicator 15
raw image status 91
Ready 77
recommended cleaning solutions 95
Region of Interest (ROI), button 85
region used to calculate exposure index 91
reject

Accepted image 94
image 92–93

Reject Analysis 92
Reject Bin 92
Reject button 46, 92, 94
rejected image, asterisk 92
Remove Unexposed Views 76
Repreview, using 67
reprint images 66
resend 66
Resend Stopped Job button 69
reset UPS 30
restart

Gantry with mobile VPOS 115
system after Emergency 29

restart system in Sleep mode 29
retract/engage grid 16
Retrieve Priors 70
Review button 93
Review dialog box

thumbnails, accepted images 93
view tab 93–94

review reject Accepted image 94
Rotation Angle displays 19
rotation switches

C-arm and Gantry 25
Gantry 19

S
safety

isolation integrity 1
mechanical 5
mobile requirements 116
radiation 5

screening exam sequence 44
screens

Patient view 43
Preview Image 43, 79
Review dialog box 93
Select a Patient 43
View Order Editor 61
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T

search
hints for use 48
Local Exams 44, 48
retrieve priors 70

SecurView TechMate 11
select

AEC position with keyboard 16
AEC sensor position 58
breast density in TEC mode 16
exposure techniques 16
grid position 16
outputs 53

Select a Patient screen 43, 47
Selenia Display 14
send

accepted rejected images to outputs 94
images to an output-post procedure 66

sensor position, AEC 58
Set Rejected button 94
Set Technique Defaults screens 60
shield

patient face 5
radiation 5

shutdown, how to 32
Simulate Capture, button 73
Smart Paddle, functions 28
Smart paddles 36
SMPTE pattern 71
software version 72
specifications, mobile 117
spool

accepted images 91
full resolution image sent to 91

Standard Setup screens 60
status, image 91
stopped job in queue, resend 69
switch users 32
switches

AWS and Value Console circuit breakers 12
Gantry circuit breaker 19
Vertical Position Override 115

symbols, international, defined xix
system

controls and functional tests 25
description 11
restart in sleep mode 29
tests after transport 118

system messages 73
system tests 29

T
TEC

Exposure mode 56
Override mode 57
select Exposure Mode with keyboard 16

TechMate 11
controls 18
display 18
power button 18, 23

technical information 102–110
exposure modes 111
printers 113
TechMate 113

technologist review workstation 11
technologist, default view order 75
temperature (IR) 72
terms and definitions xvii
test patterns 71
tests

after transport 118
monthly system 29

thumbnails 93
tools, list of image enhancement and annotation 81
Totoku display 17
trackball 14–15

care and cleaning 96
tubestand, components 11, 19
turning on system in Sleep mode 29

U
unprotect patients 67
UPS

reset, TechMate 31
resetting Selenia 30
shut down Acquisition Workstation 30
Value Console, location 14

UPS reset button, Acquisition Workstation 14
user

add or edit 62
delete 62

User Interface Screens 43
user setup function 62
User Training xvi
users, OS/Application names & passwords 24

V
Value Console

circuit breaker location and function 12
description 11

Vertical Position Override switch 115
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W

view
default order 75
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